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Introduction 

Date published: Friday 12th December 2025.  

Giltrex Ltd., London UK. 

In This Section 

Welcome to Avrella 

System Requirements 

Overview 

License Agreement 

Uninstall 

Donations 

https://www.giltrex.com/


Welcome to Avrella 

Avrella - music score editor. 

Trust that you enjoy using this program, and that it meets your requirements. All feedback 

both positive and negative on this program is welcome.  

Giltrex Ltd. 

email contact 

 

 

 

 

 

https://www.giltrex.com/
https://www.giltrex.com/about/


System Requirements 

IBM PC or compatible. 

Sound Blaster or compatible Sound card. 

Operating Systems: Windows 10 /11 

Preferred minimum Screen resolution: 1024 x 768. 

 

 

To change the Windows screen resolution: 

Windows 10 / 11 

1. On the Windows Desktop, click the right mouse button to launch the Pop-Up menu and 

select Display Settings.. 

2. Scroll down to Display resolution to set to the resolution you wish. 

 

 

 

 

 

 



Overview 

The program has been designed with the intention of allowing the musician to easily create 

and maintain scores with the minimum of hassle. 

 

 

Features include: 

Straightforward insertion of notation. 

Drag notation / text into place. 

Insert / edit lyrics on screen. 

Guitar notation - chords symbols, bends, vibrato etc. 

Supports Tablature. 

Support of user designed fonts for notation. - including user specific symbols. 

Property dialog - facilitating editing. 

Up to 32 staves per score* 

Import / Export MIDI files.  

Online Help. 

 

Plus many more features. It is recommended that you start by working your way through the 

tutorial which will give you a basic idea of how to use the program. It is well worth the 30 

minutes or so that it'll take you. In time of course you will find many useful features, but for 

now our intent is just to get you easily started. 

Finally if it's not there and you think it ought to be, then email support by all means, whether 

it be to inform us of a feature for which you consider the user interface is not straightforward 

or if there is a feature which you would like to see included. Note: Because of the huge 

https://www.giltrex.com/support


increase in spam, please put the product name: "Avrella" in the subject header to ensure 

that your email does not accidentally get marked as spam. 

* 32 staves per score was just a logical limit put in. This can certainly be increased. Email if 

you find this limit is insufficient. 

 

 



License Agreement 

Freeware Licence Agreement 

This licence agreement only applies to the free version of Avrella software. "Software" is 

defined as the Avrella software program, which includes software components installed by 

the setup program. By installing, copying, or otherwise using this Software, you agree to be 

bound by the terms of this License Agreement. If you do not agree to the terms of this 

License Agreement, you must immediately terminate your use of this Software and you 

must delete it completely from your computer system, such as by using the Uninstall option 

included in the Windows folder that is installed for Avrella.  

Terms and Conditions 

BY DOWNLOADING, INSTALLING, USING, TRANSMITTING, DISTRIBUTING OR 

COPYING THIS SOFTWARE ("THE SOFTWARE"), YOU AGREE TO THE TERMS OF 

THIS AGREEMENT (INCLUDING THE SOFTWARE LICENCE AND DISCLAIMER OF 

WARRANTY) WITH GILTREX LTD THE OWNER OF ALL RIGHTS IN RESPECT OF THE 

SOFTWARE. 

Please read this document carefully before using the software. 

IF YOU DO NOT AGREE TO ANY OF THE TERMS OF THIS LICENCE THEN DO NOT 

DOWNLOAD, INSTALL, USE, TRANSMIT, DISTRIBUTE OR COPY THE SOFTWARE. 

THIS DOCUMENT CONSTITUTES A LICENCE TO USE THE SOFTWARE ON THE 

TERMS AND CONDITIONS APPEARING BELOW. 

The Software is licensed to you without charge for use only upon the terms of this licence, 

and Giltrex Ltd. reserves all rights not expressly granted to you. Giltrex Ltd. retains 

ownership of all copies of the Software. 

1. Licence 

You may use the Software without charge. 

You may distribute exact copies of the Software to anyone. 

2. Restrictions 

Giltrex Ltd. reserves the right to revoke the above distribution right at any time, for any or no 

reason. 



YOU MAY NOT MODIFY, ADAPT, TRANSLATE, RENT, LEASE, LOAN, SELL, ONSELL, 

REQUEST DONATIONS OR CREATE DERIVATE WORKS BASED UPON THE 

SOFTWARE OR ANY PART THEREOF. 

The Software may contain trade secrets/source code and to protect them you may not 

decompile, reverse engineer, disassemble or otherwise reduce the Software to a humanly 

perceivable form. You agree not to divulge, directly or indirectly, until such trade 

secrets/source code cease to be confidential, for any reason not your own fault. 

3. Termination 

This licence is effective until terminated. The Licence will terminate automatically without 

notice from Giltrex Ltd. if you fail to comply with any provision of this Licence. Upon 

termination you must destroy the Software and all copies thereof. You may terminate this 

Licence at any time by destroying the Software and all copies thereof. Upon termination of 

this licence for any reason you shall continue to be bound by the provisions of Section 2 

above. Termination will be without prejudice to any rights Giltrex Ltd. may have as a result 

of this agreement. 

4. Disclaimer of Warranty, Limitation of Remedies 

TO THE FULL EXTENT PERMITTED BY LAW, GILTREX LTD HEREBY EXCLUDES ALL 

CONDITIONS AND WARRANTIES, WHETHER IMPOSED BY STATUTE OR BY 

OPERATION OF LAW OR OTHERWISE, NOT EXPRESSLY SET OUT HEREIN. THE 

SOFTWARE, AND ALL ACCOMPANYING FILES, DATA AND MATERIALS ARE 

DISTRIBUTED "AS IS" AND WITH NO WARRANTIES OF ANY KIND, WHETHER 

EXPRESS OR IMPLIED. GILTREX LTD DOES NOT WARRANT, GUARANTEE OR MAKE 

ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF 

THE SOFTWARE WITH RESPECT TO ITS CORRECTNESS, ACCURACY, RELIABILITY, 

CURRENTNESS OR OTHERWISE. THE ENTIRE RISK OF USING THE SOFTWARE IS 

ASSUMED BY YOU. GILTREX LTD MAKES NO EXPRESS OR IMPLIED WARRANTIES 

OR CONDITIONS INCLUDING, WITHOUT LIMITATION, THE WARRANTIES OF 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO 

THE SOFTWARE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 

GILTREX LTD, IT'S DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A 

WARRANTY, AND YOU MAY NOT RELY ON ANY SUCH INFORMATION OR ADVICE. 



IMPORTANT NOTE: Nothing in this Agreement is intended or shall be construed as 

excluding or modifying any statutory rights, warranties or conditions which by virtue of any 

national or state Fair Trading, Trade Practices or other such consumer legislation may not 

be modified or excluded. If permitted by such legislation, however, Giltrex Ltd. liability for 

any breach of any such warranty or condition shall be and is hereby limited to the supply of 

the Software licensed hereunder again as Giltrex Ltd at its sole discretion may determine to 

be necessary to correct the said breach. 

IN NO EVENT SHALL GILTREX LTD BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 

INDIRECT OR CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT LIMITATION, 

DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, AND THE 

LOSS OF BUSINESS INFORMATION OR COMPUTER PROGRAMS), EVEN IF GILTREX 

LTD OR ANY GILTREX LTD REPRESENTATIVE HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. IN ADDITION, IN NO EVENT DOES GILTREX LTD 

AUTHORISE YOU TO USE THE SOFTWARE IN SITUATIONS WHERE FAILURE OF THE 

SOFTWARE TO PERFORM CAN REASONABLY BE EXPECTED TO RESULT IN A 

PHYSICAL INJURY, OR IN LOSS OF LIFE. ANY SUCH USE BY YOU IS ENTIRELY AT 

YOUR OWN RISK, AND YOU AGREE TO HOLD GILTREX LTD HARMLESS FROM ANY 

CLAIMS OR LOSSES RELATING TO SUCH UNAUTHORISED USE. 

5. General 

All rights of any kind in the Software which are not expressly granted in this Agreement are 

entirely and exclusively reserved to and by Giltrex Ltd. 

This Agreement shall be governed by the laws of the United Kingdom. Exclusive jurisdiction 

and venue for all matters relating to this Agreement shall be in courts and fora located in the 

United Kingdom, and you consent to such jurisdiction and venue. This agreement contains 

the entire Agreement between the parties hereto with respect to the subject matter hereof, 

and supersedes all prior agreements and/or understandings (oral or written). Failure or 

delay by Giltrex Ltd. in enforcing any right or provision hereof shall not be deemed a waiver 

of such provision or right with respect to the instant or any subsequent breach. If any 

provision of this Agreement shall be held by a court of competent jurisdiction to be contrary 

to law, that provision will be enforced to the maximum extent permissible, and the remaining 

provisions of this Agreement will remain in force and effect. 

Sound Blaster AWE32 and Sound Blaster 16 are trademarks of Creative Technology Ltd. 

Dell is a registered trademark of Dell Computer Corporation. Avrella is a trademark of 



Giltrex Ltd. Intel, Pentium are registered trademarks of Intel Corporation. IBM and AT are 

registered trademarks and PC/XT are trademarks of International Business Machines 

Corporation. Microsoft, MS, MS-DOS are registered trademarks and Windows, Win32, 

Windows NT and Windows 10 and 11 are trademarks of Microsoft Corporation. Firefox is a 

trademark of The Mozilla Organization. Netscape Communicator is a trademark of 

Netscape Communications Corporation. Java is a registered trademark of Sun 

Microsystems. All other products are registered trademarks or trademarks of their 

respective owners. 

 



Uninstall 

As part of the installation setup, an uninstall icon is added to the Avrella folder. Run this to 

remove Avrella from your system. (You may also uninstall via Control Panel -> Add or 

Remove Programs.) 

 

 



Donations 

Any donatations however small towards helping the maintenance and further development 

of this software program are greatly appreciated.  

Click here to donate (or the donate link in the Help About Dialog). 

https://www.giltrex.com/donate


Menus 

In This Section 

Menu descriptions 

File menu 

Edit menu 

View menu 

Insert menu 

Format menu 

Tools menu 

Score menu 

Window menu 

Help menu 



Menu descriptions 

 

File menu 

Edit menu 

View menu 

Insert menu 

Format menu 

Tools menu 

Score menu 

Window menu 

Help menu 

 



Palettes 

In This Section 

Guitar Palette command (Window menu) 

Standard Palette command (Window menu) 

Show Palettes 

Supplementary Palette command (Window menu) 



Show Palettes 

Use these commands to display and hide Guitar, Standard and Supplementary Palettes.  

 

Window Guitar Palette command to display and hide the Guitar Palette. 

 

Window Standard Palette command to display and hide the Standard Palette. 

 

Window Supplementary Palette command to display and hide the Supplementary Palette.  



How To 

In This Section 

Create Custom Notation Fonts 

Editing notation, symbols, text etc. 

Lyrics - insertion and presentation 

Navigating around the score 

Score Presentation 



Create Custom Notation Fonts 

The notation in Avrella is drawn by selecting a specially designed notation font that has 

been created and matched specifically for this program. The two fonts supplied with the 

program are Avrella Standard Type 1 and Avrella Freestyle Type 1. 

 

To create your own custom Font notation - or even if you just want to improve on the 

supplied fonts you will require a software package designed to create fonts such as 

Fontographer or Softy. 

 

Guidelines for creating your own font 

 

Copy one of the standard supplied fonts either Avrella Standard Type 1 or Avrella Freestyle 

Type 1 to the name of your new font file - e.g. From a command prompt box: 

 

C:\MyDevelopmentFontDirectory> copy AvrellaStdType1.ttf avrmyfont.ttf 

 

(Copies of the Avrella font files are located in the res\Fonts subdirectory to the Avrella 

program installation - e.g. "C:\Program Files\Avrella\res\Fonts" if Avrella was installed in 

"C:\Program Files\Avrella".) 

 

Modify the glyphs as desired - ensuring that the actual scale size of the glyph is not altered - 

altering the scale size will have dire effects on how your new font will size verses staff lines 

etc. when loaded. For example if modifying a glyph for which the size is 1200 X 3000 it is 

important to ensure that the overall size is not changed, plus that the horizontal mid line and 

vertical line positions are not changed. Given this you are free to alter the style of the glyph. 

 

A word of advise - going from scratch and redesigning a font is a time consuming business. 

You are therefore advised to take many backups along the way. Plus if you are new to Font 

editing then it is easy to make mistakes and unknowingly lose your work. Also it is advisable 



during development to try installing your new Font often, so as to check just how it looks in 

the Avrella Program. 

 

Important Note: The font family name must commence with the word Avr - this is very 

important as Avr is used as a filter when selecting the fonts to display in the Document 

Setup dialog box - (to prevent other inappropriate fonts for the Avrella program being 

displayed). In the case of MyFont typical entries are shown below alongside those of the 

Avrella Standard Type 1 Font for comparison. 

 

 

   

 Avrella Standard MyFont 

Family Avrella Standard Type 1 Avr MyFont 

Sub Family Regular Regular 

Identifier Avrella Standard Type 1 MyFont 

Full Name Avrella Standard Type 1 Regular MyFont Regular 

Version Version 1.00 Version 1.00 

Trademark   

 

Having completed MyFont - you can now install it. From the Start taskbar option - select 

Settings and choose the Control Panel folder. The Control Panel folder will open and you 

will see a Fonts folder - clicking on this will display all the fonts that you currently have 

installed on your computer. Select File -> Install New Font. The Add Fonts dialog box will 

open - select the directory where your font file MyFont.ttf resides - in this example 

C:\MyDevelopmentFontDirectory Select MyFont and click OK to install. 

 



On selecting the fonts to display in the Document Setup dialog box - you will now find ‘Avr 

MyFont’ which may now be selected as the chosen font for a particular score. 



Editing notation, symbols, text etc. 

This is a brief guide to the main editing functions for a score. (If you are new to Avrella then 

it is strongly recommended that you work your way through the tutorial, although this 

section is included as a quick refresher which just covers the basics.) 

Having entered the notation for the score. 

Use the Properties Dialog to change General Attributes, Style and ornamentation 

associated with notation (note, rest or chord).  

Use the context menu for copy, cut paste actions for notation and whole measures. 

Drag object into place.  

Undo / Redo previous edit action on notation / symbol. 

 

 

 

 



Lyrics - insertion and presentation 

This is a brief guide to creating lyrics for your score and setting them up to your liking. 

To demonstrate we will make use of a fictitious and simple example by using dummy 

numbered words so that you can better keep track of where each word should be placed on 

changing the score.  

Using the LyricDemo.avrella example below (a copy is in the Examples directory): 

 

 

Dummy lyric words have been set up as shown, to align with the notes in the staff above. 

Once inserted the start of the lyric words will have a fixed xratio so that if the width of the 

measure is altered by for example changing the measures / system (Score -> Measures per 

System) or Format -> Current Measure -> Width, then the lyrics will maintain their xratio so 

that the start of the word will still be aligned with the notation in the staff above.  

To adjust the vertical positioning of the lyrics between staffs select File->Document Setup 

for the Document Setup Dialog and adjust the Lyric Lines Y offset control to suit. 

Some general points concerning use of lyrics: 

 

On changing the zoom size for the display the closest font match is made to the appropriate 

zoom size. Ref: Text Style / Lyric Format Tab 

On initial insert - the start of the lyric word is precise for the set xratio. However on 

subsequently changing the width of a measure etc. it will be the closest match for the xratio 

(within less than a half of one character space size). Thus it is considered preferable to 

have decided upon the width of measures and general layout of your score before aligning 

the lyric text. 



For the very best possible printed output it is preferable to align the lyric text when in zoom 

100% (the same scale size used for printed output).  

If the width of the measure is reduced to an extent whereby there is no room for the lyric 

text in the measure then the words will push over into the next measure. An example of this 

is shown below:  

 

 

    



Navigating around the score 

This is a brief guide as to how to navigate around the score. If you are new to Avrella then it 

is strongly recommended that you work your way through the tutorial, although this section 

is included as a quick refresher which covers the basics 

Use of cursor - positioning etc. 

Go To Measure  Dialog. 

Go To Page Dialog. 

Previous Page, Next Page, First Page, Last Page. 

 

 

 

 



Score Presentation 

This is a brief guide* as to some of the ways in which you may present format the score to 

your liking.  

Use the File -> Document Setup Dialog for positioning of staff separation etc. 

File -> Details Dialog for Score Title, copyright information, Header and Footer information 

etc. 

Use the File -> Framework Dialog for basic staff layout plus staff names etc. 

Drag notation into place. 

Format -> Current Measure -> Width, Bar Markings etc. 

Format -> Lyric to change Font Settings for selected Lyric line. 

Format -> Note Separation Measure / Note Separation Page. (Can override default spacing 

for measure - note x ratio (displayed in status bar when notation highlighted, and use Alt -> 

(Hold down left hand Alt key and press right cursor arrow) to increase Alt <- to decrease 

value.)  

Score -> Measures per System to specify desired number of measures for system(s). 

*If you are new to Avrella then it is strongly recommended that you work your way through 

the tutorial, although this section is included as a quick refresher which just covers the 

basics. 

    



Troubleshooting 

In This Section 

Tips file not found. 

How to get further help 



Tips file not found. 

 

 

   

 This is likely to be due to one of the following causes:  

1. 
Confirm that the tooltip files (AdvTips.txt and BegTips.txt) are in the Program installation 

directory. 
 

2. 

Internal error: Program not specifying full pathname on opening file and using current 

(default) directory. A workaround is to set up The Program Start Directory for the 

application luaunch. 

 

 

a) If launched from Start menu: Select the start menu and navigate to the Avrella icon, 

although do not click the left hand mouse button to launch the program. Instead click the 

right hand mouse button which displays the context menu. Select Properties and click on 

The Shortcut Tab.  

b) If launched from Desktop icon. Click the right hand mouse button which displays the 

context menu. Select Properties and click on The Shortcut Tab.  

Confirm that the start directory is the same as the program installation directory. (i.e. 

same as Target field above less "\Avrella.exe") 

Typically: 

 



 

 

   

 

 

 

 



How to get further help 

If your have further queries / problems that are not answered by this help file. Then it is 

recommended that you visit our website www.giltrex.com and navigate to The Support 

section for further help.  

https://www.giltrex.com/


Glossary of Terms 
 

Glossary of musical terms 

    

8va Accent Accidental Alla Breve 

Chord Clef Common Time Compound Time 

Crescendo Dash Decrescendo Dotted Notes / Rests 

Dynamic Range Parentheses note Grace notes Interval 

Key Signature Mordent Ottava Pause 

Simple Time Slur Staccatissimo Staccato 

Tempo Time Signature Tonal Range Tone 

Tremolo Tuplet Turn Vibrato 

    

The above list is by no means comprehensive, just listing a few musical terms. Far more 

comprehensive dictionaries may be found on the Net. One such being at Dolmetsch online 

(Link correct: November 2009) 

    

Technical 

    

ADC Amplitude Bandwidth DAC 

Decibel Hertz Reverberation  

    

 

http://www.dolmetsch.com/musictheorydefs.htm


File menu 

The File menu offers the following commands: 

  

New Creates a new document. 

Open Opens an existing document. 

Close Closes a document. 

Save Saves an opened document using the same file name. 

Save As Saves an opened document to a different file name. 

Save All Saves all opened documents. 

Print Prints a document. 

Print Preview Displays the document on the screen as it will appear printed. 

Print Setup Selects a printer and printer connection. 

Document Setup Define style for this score. - header space etc. 

Details  Define score title, header etc. 

Framework Define basic framework of score - number of staffs etc. 

Exit  Exits Avrella. 

 



Edit menu 

The Edit menu offers the following commands: 

 

  

Undo Reverse previous editing operation. 

Redo Redo previous undo operation. 

Cut Deletes data from the document and moves it to application data buffer. 

Copy Copies data from the document to the application data buffer. 

Paste Pastes data from the application data buffer into the document. 

Standard Entry Standard Entry - select standard input entry. 

Clear Current 

Measure 
Clears all notation etc. from the current measure. 

Hard Clear 

Current Measure 

As above, but will remove any Clefs, Key & Time Signatures and Tempos 

in the measure as selected via Items to delete in addition to notation 

Dialog 

Delete Measure Launches Delete Measure Dialog to specify measure(s) to be deleted. 

Lyrics Switch between edit and view mode for lyrics 

Delete Lyric Line Having selected edit via Lyrics command used to remove entire lyric line  

Go To Measure  Launches Go To Measure Dialog to specify measure to go to. 

Go To Page Launches Go To Page Dialog to specify measure to go to. 

 



View menu 

The View menu offers the following commands: 

  

Toolbars Shows or hides the toolbars. 

Status Bar Shows or hides the status bar. 

Zoom Zoom dialog. 

Refresh Display Refresh Display. 

Volume Graph Overlays MIDI volume settings for notation. 

First Page Go to the first page in the score. 

Previous Page Go to the previous page in the score. 

Next Page Go to the next page in the score. 

Last Page Go to the last page in the score. 

 



Insert menu 

The Insert menu offers the following commands: 

  

Note Insert note into score. 

Notation Insert various notation Clef, Key Sig. Tempo into score. 

Rest Insert rest into score. 

Lyric Line Insert lyric line into score. 

Text Insert text into score. 

Measure Insert measure(s) into score. 

 



Format menu 

The Format menu offers the following commands: 

  

Time Interval Set time interval for notation to be inserted. 

Accidentals Set up appropriate accidental to take effect for insertion of notes. 

Dots Set appropriate dot period to take effect for insertion of notes / rests. 

Tuplet Sets entry mode to tuplet. 

Tuplet Parameter Format tuplet parameters/ratio. 

Lyric Set character format for lyric line. 

Current Measure Set properties for current measure. 

Note separation Meas. Format measure for standard note separation based on time interval. 

Note separation Page Format page for standard note separation based on time interval. 

 

    



Tools menu 

The Tools menu offers the following commands: 

  

Record 

Currently record facility from a Midi keyboard is not supported. However this is to be 

implemented in a future 1.xx release of Avrella. Although by use of a Midi 

sequencer you may record a Midi file and then import the generated. A 

recommended Midi sequencer is Jazz++ freely available from www.jazzware.com 

Play Plays the current score. 

Pause Pauses the playing of the current score. 

Stop Stops the playing of the current score.  

Volume Define MIDI volume level for a range of notation. 

Options Sets entry mode to tuplet. 

 



Score menu 

The Score menu offers the following commands: 

  

Insert Page Inserts new page(s) into score. 

Delete Current Page Delete current page from score. 

Clear Current Page Clears current page of notation. 

Measures per system Sets measures per system. 

 

    



Window menu 

The Window menu offers the following commands, which enable you to arrange multiple 

views of multiple documents in the application window: 

 

  

Standard Palette Shows or hides the standard palette. 

Guitar Palette Shows or hides the guitar palette. 

Supplementary Palette Shows or hides the supplementary palette. 

New Window Creates a new window that views the same document. 

Cascade Arranges windows in an overlapped fashion. 

Tile Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of closed windows. 

Window 1, 2, ... Goes to specified window. 

 

    



Help menu 

The Help menu offers the following commands, which provide you assistance with this 

application:  

  

Tip of the 

Day 
Shows tip of the day. 

Contents Display Help Contents 

Tutorial 

Launch the Avrella Beginners Tutorial.  

(Note: For the registered version, if you switch off Display tutorial message 

boxes and notes, this menu item will not be displayed.) 

About 

Displays the About Dialog box  

Shows version release information plus links to website, product support and 

donation page. 

 

 

    



Guitar Palette command (Window menu) 

Use this command to display and hide the Guitar Palette.  



Standard Palette command (Window menu) 

Use this command to display and hide the Standard Palette.  

 

 



Supplementary Palette command (Window menu) 

Use this command to display and hide the Supplementary Palette.  



Guitar Palette 

The guitar palette allows you to enter various common marks, symbols etc. related to the 

guitar. 

 

 

 

 

Click on the appropriate palette item for further information. 



Standard Palette 

The standard palette allows you to enter various common marks, symbols and notation into 

the score. 

 

 

 

 

Click on the appropriate palette item for further information. 



Supplementary Palette 

The supplementary palette allows you to enter various common marks, symbols etc. related 

to the guitar. 

Important Note: All the symbols in the supplementary palette can be selected by association 

with the relevant notation by use of the Properties Dialogs for Objects - which is absolutely 

the preferred method. However it is recognised that there may be the odd occasion for 

which you might wish to insert one of these symbols without any particular association to a 

note. It is for this purpose that the Supplementary Palette is provided. 

 

 

 

 

Click on the appropriate palette item for further information. 



Font Software Packages 

Macromedias Fontographer  

The best known. However if you are just going to be a part time user then it does not come 

cheap. 

Fontographer 4.1.5 - US $349. 

The Avrella Standard Type 1 and Freestyle Type 1 fonts were developed for release using 

this package. 

Macromedia had not continued further development of this program from the current 4.1 

release dated 1996. However in May 2005 it was announced that FontLab would licence the 

Fontographer product line from Macromedia. Along with this announcement was the 

commitment to work on fixing bugs and preparing a new version. The current Windows 

release is 4.1.5. 

FontLab  

FontLab Studio 5.0 - US $649. 

TypeTool* 2.0 US $99. 

*Lite version of FontLab - does the basics. 

Softy by D.W. Emmett  

The original Avrella Standard and Freestyle fonts were created using this editor. Whilst not 

having all features of its more expensive rivals - the price is just £15 (approx US $25) - good 

value for money. Link to Softy Homepage at 

www.giltrex.com/Avrella/Fonts/FontSoftwarePackages.htm 

(All prices quoted were taken February 2006) 

Further information - ref. TrueType and Font Tools etc. - check out - www.truetype-

typography.com 

Check out www.giltrex.com/Avrella/Fonts/Fonts.htm for current information 

http://www.fontlab.com/font-editor/fontographer
http://www.fontlab.com/
http://www.giltrex.com/Avrella/Fonts/FontSoftwarePackages.htm
http://www.truetype-typography.com/
http://www.truetype-typography.com/
http://www.giltrex.com/Avrella/Fonts/Fonts.htm


Properties Dialogs for Objects - overview 

One of the most useful features for ease of editing the notation is the Properties dialog 

(selected by double clicking on the supported notation object) which consists of an array of 

Property Sheets, the number and type dependant on the object selected. 

 

  

Notation 

object 
Property sheets displayed 

Note 
Properties - General; Properties Style; Properties - Ornamentation; Properties 

- Ornam #2; Properties - Tab. (Note)*  

Chord 
Properties - General; Properties Style; Properties - Symbol; Properties - Tab. 

(Chord)*  

Rest Properties - General 

 *Only displayed if tablature staff below notation. 

 



Pull Right context sensitive menu 

Various editing facilities are available dependant on the position of the cursor and thus the 

object type selected, through the pull right (context sensitive) menu (PRM): 

(For the sake of clarity the popup menus for all objects are not listed here. A full list of 

objects can be found by reference to Object Classification, which along with all the available 

objects lists the family groups. Objects in the same family group can be manipulated in a 

similar manner to each other, having similar popup menus etc.) 

 

   

Object Type 
PRM 

options 
Description 

Note Cut note  Cuts the note to memory buffer. 

 Copy note  Copies the note to memory buffer. 

 Flip tail 
Inverts the tail direction - e.g. if tail up displays note 

with tail down. 

 
Property 

Summary 

Displays summary of note properties: Staff No., 

Measure No. and X Ratio. 

Chord Cut chord  Cuts the chord to memory buffer. 

 Copy chord Copies the chord to memory buffer. 

 
Delete 

chord note 

Deletes the highlighted chord note from the chord - 

have to place cursor precisely on the chord note. (If 

the Chord note deleted results in just one note 

remaining - object reverts to note type.) 

 
Flip note 

horiz. 

Will display the chord note in the other horizontal 

direction. This is an aid to presentation for typically 

the case where two notes are a half staffline space 

apart. 



 Flip tail 
Inverts the tail direction - e.g. if tail up displays note 

with tail down. 

 
Property 

Summary 

Displays summary of chord properties: Staff No., 

Measure No. and X Ratio.  

Mark Delete  Deletes the highlighted mark. 

 

Solid-

>Dotted-

>Dashed 

Set mark as Solid Dotted or Dashed.* (If mark is 

currently Solid selecting sets it to Dotted. Selecting 

again sets it to Dashed. Selecting again sets it 

back to Solid etc.) 

* applies to some marks only. 

Only applicable for slur Flip slur 
Inverts the slur sweep - e.g. if slur sweeps up 

displays slur sweep down. 

 
Property 

Summary 

Displays summary of Mark properties: Staff No. 

and Measure No. 

Other (non associated) 

objects (Pause; Chord 

Diagram; Accents etc.)   

Cut  Cuts the object to memory buffer. 

 Copy object Copies the object to memory buffer. 

 
Property 

Summary 

Displays summary of object properties: Staff No. 

and Measure No. 

No object selected and 

object stored in memory 

buffer  

Paste 

[object] 

 

Inserts the cut / copied object stored in the memory 

buffer into the score at the selected position. 

 
Flush 

[object] 

Flushes the cut / copied object from the memory 

buffer - note this action required if you have cut a 

note and now wish to use the Measure PRM 

options - see below. 



No object selected - cursor 

within measure grid lines - 

plus no object stored in 

memory buffer - ref.: above 

Clear (Cut) 

Measure  

 

Cuts the measure to memory buffer. Note this only 

deletes the regular objects in the measure. It does 

not delete Clef, Key Sig, Time Sig and Tempo data 

related to this measure. (Ref.: Edit -> Hard Clear 

Current Measure for this facility.)  

 
Copy 

Measure  

Copy the measure to memory buffer. Note this only 

copies the regular objects in the measure. It does 

not copy Clef, Key Sig, Time Sig and Tempo data 

related to this measure. 

 
Paste 

Measure 

Pastes the measure buffer contents to the selected 

measure.  

 
Default 

Spacing 

Sets the default spacing for notation in measure - 

ref.: Note Separation 

 

 

    



Moving / Dragging objects 

Certain objects entered in the score may be re-positioned by moving / dragging them into 

the desired position. 

 

   

Object Highlight by Move properties 

Note Clicking on note head. 

x axis - within measure; y axis - up / down for 

staff. Also to move a note by a fine amount 

Select Alt + <- / -> (i.e. hold down the Alt key 

and select the left arrow or right arrow) and the 

note will be shifted by 0.25% X ratio - the value 

for the Xratio is displayed to the right in the 

status bar if it has been selected via Tools-

>Options->Status Bar Tab. 

Beam tails 

 

Click on tail at either 

end of the beam. 

To lengthen the tail at either end of a beam - 

e.g. a beamed group of 4 16ths as shown: 

 

click on either end and drag tail up or down. 

(*An alternative method is highlighting the start / 

end note tail head and selecting Alt + ^ / v (i.e. 

hold down the Alt key and select the up arrow or 

down arrow) 

Rest Clicking on centre. x axis - within measure 

Chord Clicking on note head. 
x axis - within measure; y axis - individual note 

heads up / down 

Standard Palette 

Crescendo 
Clicking on the left 

intersection. 
Can't move once placed. 



Decrescendo 
Clicking on the bottom 

left point. 
Can't move once placed. 

Slur 
Clicking on the 'starting' 

left point. 
Can't move once placed. 

3 point 

Clicking on the start 

point (when created - if 

not highlighted on the 

left hand start point - 

click on the other end).  

Can't move once placed. 

Free slur / Line / 

Bracket 

Clicking on the 'starting' 

left point. 
Can't move once placed. 

Guitar Palette 

Bend (slope) 
Clicking on the 'starting' 

left point. 
Can't move once placed. 

Bend (straight) 
Clicking on the 'starting' 

bottom point. 
Can't move once placed. 

Bend and release 
Clicking on the 'starting' 

left point. 
Can't move once placed. 

Bend, hold and 

release 

Clicking on the 'starting' 

bottom point. 
Can't move once placed. 

Hammer / pull 
Clicking on the 'starting' 

left point. 
Can't move once placed. 

Chord diagram 
Clicking on the bottom 

left of the grid. 
x axis - within system, y axis - within staff. 

Vibrato / Wide 

vibrato / Vibrato + 

wang 

Clicking on the 'starting' 

left point. 
Can't move once placed. 



Supplementary Palette 

Accidental / 

Accent / Mordent / 

Pause / Turn / 

Custom 

Clicking on the centre. x axis - within system, y axis - within staff. 

Grace Clicking at the bottom. x axis - within system, y axis - within staff. 

 

 

 

    



Undo/Can't Undo command (Edit menu) 

Use this command to reverse the last editing action, if possible. The name of the command 

changes, depending on what the last action was. The Undo command changes to Can't 

Undo on the menu if you cannot reverse your last action. 

Shortcuts 

Toolbar: 

 

Keys:  

CTRL+Z or 

ALT-BACKSPACE  

 



Redo/Can't Redo command (Edit menu) 

Use this command to redo the last undo action, if possible. The name of the command 

changes in the menu, depending on what the last undo was. The Redo command changes 

to Can't Redo on the menu if you cannot reverse your last action. 

Shortcuts 

Toolbar: 

 

 

Keys:  

CTRL+Y 

 

 

 



Measures per System (Score menu) 

Use this command to define measures for a particular system in the score. On selecting this 

command the Measures per system dialog box is displayed. 

 



Width Tab 

Allows the width of the measure to be altered. 

 

  

LHS 

spinbutton 

Set the width of the left hand side of the measure to between -35% and 

+35% of its standard width. 

RHS 

spinbutton 

Set the width of the right hand side of the measure to between -35% and 

+35% of its standard width. 

Set Default Set the width of measure to standard width. 

 

Note: For the case where the measure is at the start of system, left hand side of measure 

may not be altered. Conversely where the measure is at end of system, right hand side of 

measure may not be altered. 

 



File Document Setup Tabbed Dialog 

 

The two dialog tabs Active Document and New Document allow set up of the style settings 

for the active document plus the default settings for any new document created. The 

operation of the controls for these two tabs is identical, the former Active affecting the 

current document, the latter New setting the defaults for any subsequent new documents 

created. 

 

  

Page 

groupbox 
 

Header slider 
Sets header as measured in staffline space units between the top of the 

page and the top of the first staff. Can be set from 8 through to 16. 

Staff separation 

slider 

Sets separation as measured in staffline space units between the staffs in a 

system. Can be set from 6 through to 12. 

Left margin 

slider 

Sets left hand margin for the score as measured in quarter-staffline space 

units between the staffs in a system. Can be set from 7 through to 13. 

 

 

  

First Page 

groupbox 
 

Header Indent 

slider 

 

Sets indentation of initial system on the first page of the score. Can be set 

from 0 (no indentation) to 7 staffline space units.The indentation set is in 

addition to the page header. 

 

  



First System 

Indent groupbox 
 

Slider 
Sets left margin indentation of initial system on the first page of the 

score. Can be set from 0 (no indentation) to 10 staffline space units. 

 

Notation Type Face combo box. 

Select the notation font style for this document. There are two notation fonts supplied with 

Avrella - 'Avrella Standard Type 1' and 'Avrella Freestyle Type 1'. On selection a sample 

output is displayed below the combo box. You are free to design your own fonts for use with 

Avrella - refer to Creating custom notation fonts for Avrella. 

 

Tempo push button 

Select this button to set up the initial tempo setting. On selecting this button a Tempo dialog 

box is displayed. 

Midi Volume Button  

(New Documents Tab only) 

Select this button to set the default midi volume for note entry when creating a new 

document. On selecting this button a Default Midi Volume for Staff Dialog is displayed. (The 

default Midi volume value set is displayed on the button.) 

Set Defaults push button 

Sets all controls to default settings. (Note - leaves tempo setting unchanged, select Tempo 

push button to set up default tempo setting) 

  

Lyric lines Y 

offset 
 

spin control 
Sets the centre offset for lyric display between staffs. (Y offset range -12 to 

12 in units of a quarter staffline space units.) 

 



 

  

Measure Nos. 

Group Box 
 

Display checkbox Displays measure numbers. 

Include first 

checkbox 
Includes the first measure number for the first measure. 

Start of system 

only checkbox 

Only displays measure number at the first measure of each system rather 

than above each measure in the system. 

Include print page 

overflow 

checkbox 

In the case where there are more staffs in the system than can fit on the 

printed page, setting this checkbox will print out the measure number at 

the top of the first staff of the next page for the continuation of the system 

printout. 

Space above staff 

spinbutton 

Set distance between the measure number and the top of the staff in 

units of half staffline line spaces. 

 

Default Measures per System spin control 

Sets the measures per system for new pages created. 

 

  

Measure No. 

Style 
 

Font Button 
Select this button to set up the font settings for the measure number. On 

selecting this button a Font dialog box is displayed. 

 

  



Acc. Spacing 

Group Box 
 

Proportional 

checkbox 

For any accent associated with a note - if this checkbox is set then the 

spacing between the accent and the note will remain proportional - 

dependant on the measure width. Consequently the accent will be drawn 

closer to the note as the measure width is reduced - converse if you 

increase the measure width. Not setting this checkbox results in the space 

being the same whatever the measure width. 

Note: This is an overall setting. You can set a particular accent to be the 

opposite of the setting here via Format -> Current Measure Layout Tabbed 

Dialog 

 

  

Tab Group 

Box 
 

Use 

checkbox 

If guitar tablature is used in the score - designates use of a tab symbol 'T' 

rather than TAB aligned vertically at the start of the system. 

Font Button 
Select this button to set up the font settings for the measure number. On 

selecting this button a Font dialog box is displayed. 

 

  

(New entry) Mark Widths Group Box  

Specify the width of the pen that draws the various marks when they are created (Note: You 

may subsequently change the width of an individual mark via the mouse right click pull right 

menu option Property Summary). The program default settings for penwidths is 1(multiplied 

by scale displayed) with the exception of Slur which is set to 4. You have the option to set 

the pen width from 0 through to 10. Note: When setting the penwidth to 0, the width will 

always be displayed as 1 pixel wide - whatever the scale size selected. 



 

Crescendo / Decrescendo {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgcres.bmp' could not 

be found.} 

Select pen width for 

crescendo 

/decrescendo. 

Slur {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_slur.bmp' could not 

be found.} 

Select pen width for 

slurs 

Lines {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_line.bmp' could not 

be found.} 

Select pen width for 

lines 

Bends {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_bend.bmp' could 

not be found.} 

Select pen width for 

bends. 

Vibrato {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_vib.bmp' could not 

be found.} 

Select pen width for 

vibrato symbol 

(guitar). 

Wide vibrato {The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_wvib.bmp' could not 

be found.} 

Select pen width for 

wide vibrato symbol 

(guitar). 

Vibrato plus tremolo{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_vib_p_w.bmp' could 

not be found.} 

Select pen width for 

vibrato plus tremolo 

action symbol (guitar). 

Width spin button 

Having selected the 

desired mark type - 

use this spin button to 

adjust the drawing 

width of the mark. 

 



    



Text Style / Lyric Format Tab 

Font Button 

Select this button to set up the font settings for the text. On selecting this button a Font 

dialog box is displayed.  

(Note that the font point size selection available refers to the font point size that will be 

displayed at Zoom / Scale size 100% (this is also the scale used for printed output). Refer to 

the Note: Further information regarding font point sizes for lyrics and text at the bottom.) 

 

  

Current Setting as 

Initialise 
Only applicable for Text Style Tab 

Save 
Saves the current settings as the default type text style on text 

entry. 

 

  

Basic Font Style  

Italics Quick method of setting to Italics, rather than going via Font Dialog box. 

 

Further information regarding font point sizes for lyrics and text at the bottom. 

On changing the zoom size for the display the closest font match is made to the appropriate 

zoom size. The lyric Font sizes (Format -> Lyric -> Style -> Font) are selectable between 

point size 8 and 11 - these values refer to the point size that will be displayed for Zoom 

100%.  

For lyric font selection the point size is between 8 and 11. For use with Text the point size is 

between 8 and 24. 

For lyrics if changing the font after lyric text entry, then due to font size differences some 

editing of the white space between lyric words may be necessary. 



 

 

 

 

    



Go To Measure command (Edit menu) 

Use this command to go to a measure in the score. On selecting this command the Go To 

Measure dialog box is displayed. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+M 

 



Go To Page command (Edit menu) 

Use this command to go to a page in the score. On selecting this command the Go To Page 

dialog box is displayed. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+G 

 



Previous Page command (View menu) 

Use this command to display the previous page of the score. 

Shortcut 

Toolbar:  

 

 



Next Page command (View menu) 

Use this command to display the next page of the score. 

Shortcut 

Toolbar:  

 



First Page command (View menu) 

Use this command to display the first page of the score. 

Shortcut 

Toolbar: 

 

 



Last Page command (View menu) 

Use this command to display the last page of the score. 

Shortcut 

Toolbar: 

 

 



Document Setup command (File menu) 

Use this command to set up the style settings for the active document plus the default 

settings for any new document created. On selecting this command Avrella displays the 

Document Setup tabbed dialog box  

 

Shortcut 

Toolbar:  

 

 



Details command (File menu) 

Use this command allows set up of Song title, header information etc. via the tabbed dialog 

with the following Tabs: 

Composition Details  

Header  

Footer  

Shortcut 

Toolbar:  

 

 



Framework command (File menu) 

Use this command to set up the basic score framework layout. Avrella displays the 

Framework dialog box  

Shortcut 

Toolbar:  

 

 



Current Measure command (Format Menu) 

Allows the set up of the current measure. There are various tabbed dialog pages which 

allow the setup of the selected measure: 

Width.  

Bar Markings.  

Ottava(8va).  

Layout  

 



Note Separation Measure command (Format 

menu) 

Format measure for standard note separation based on time interval. 

Shortcut 

Toolbar:  

 

Also when in measure boundary - pull right menu 



Ottava / 8va 

 

8va or 8:  

 

When shown over notes, indicates that the notes should be played one octave higher than 

written. If under notes - play one octave lower than written. (In which case it is common to 

write "8va bassa" - rather than just "8va" so as to avoid any possible confusion with the 

octave sign for high notes.) 

 

15ma or 15:  

The Italian abbreviation of quindicesima, indicating the interval of a fifteenth (i.e. the double 

octave). When shown over notes, indicates that the notes are to be played two octaves 

higher than written. (16va and 16ma are often mistakenly used, but a two-octave interval is 

a fifteenth thus abbreviated 15ma.) 

 



Accent 

 

To give a note a special accent or emphasis, an accent may be put over the note. Shown 

here horizontally, it is sometimes marked vertically. (Inverted V) 

  



Accidental 

Symbols used to indicate an adjustment of pitch for a standard pitch A through to G.  

 

  

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmshp.bmp' 

could not be found.} 

Sharp - adding this after a 

note raises it by a semi-

tone. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmflat.bmp' 

could not be found.} 

Flat - adding this after a 

note lowers it by a semi-

tone. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmdshp.bmp' 

could not be found.} 

Double sharp - adding this 

after a note raises it by a 

tone. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmdflt.bmp' 

could not be found.} 

Double flat - adding this 

after a note lowers it by a 

tone. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgnat.bmp' could 

not be found.} 

Natural - adding this after a 

note indicates that note is 

played as is - i.e. overrides 

any sharp or flat that 

maybe given in the score 

key signature. 

 



Alla Breve 

Use of a capital C with a vertical line through the centre to indicate alla breve* time, where 

the beats are to be minim's. However this does not define the number of beats to bar - thus 

this sign indicates 2/2 or 4/2 time. 

* Or sometimes referred to as cut common time. i.e. Common time with a cut / line through 

it. 



Clef 

Symbol on staff that determines the pitch of the note relative to it's staff position. As a rule 

the clef chosen is related to the type of instrument played, so that the majority of the notes 

written remain on the staff. 

 

The staff above shows the note middle C and its position on the staff as determined by the 

treble clef, bass clef, alto clef and tenor clef. 

 



Common Time 

Use of a capital C to indicate 4/4 time. Referred to as common time or imperfect time.  

 

(The symbol derives from a broken circle used in early music, for which a full circle 

indicated 3/4 time: "perfect time"). 



Compound Time 

With compound time the beat is usually divided into 3 parts, as opposed to simple time 

where the beat is divided into 2 parts and then often subdivided into 4 parts.  

Compound time signatures allow the beat to be divided into 3 parts and then subdivided into 

6 parts. Typical compound time signatures are 6/8, 9/8, 12/8, 6/16, 9/16, 6/4, 9/4. With 

compound time the top number in the time signature usually does not represent the number 

of beats in a measure and the bottom number usually does not represent the kind of a note 

receiving a beat. For compound time the top number usually must be divided by 3 to 

determine how many beats are in a each measure and the bottom number/note must be 

enlarged by three times to determine the type of note that equals a beat. If the bottom 

number is a 16 or 16th note then it is multiplied 3 times to a dotted eighth note which would 

be the note value for a beat.  

Rules: The beat is a dotted note and the top number is divisible by '3'.  

Examples 

 

   

Time Signature Derivation Beat value 

6/8 6/3 = 2 beats of a dotted 1/4 note (i.e. 3 x 1/8)  

9/8 9/3 = 3 beats of a dotted 1/4 note (i.e. 3 x 1/8)  

12/8 12/3 = 4 beats of a dotted 1/4 note (i.e. 3 x 1/8)  

   

6/16 6/3 = 2 beats of a dotted 1/8 note (i.e. 3 x 1/16)  

9/16 9/3 = 3 beats of a dotted 1/8 note (i.e. 3 x 1/16)  

   

6/4 6/3 = 2 beats of a dotted 1/2 note (i.e. 3 x 1/4)  

9/4 9/3 = 3 beats of a dotted 1/2 note (i.e. 3 x 1/4)  



 

 

 

 

 

 



Crescendo 

Italian term used to indicate gradually louder. Ref. Change of Volume table, 

Often the following symbol is used instead: 

 

 



Decrescendo 

Italian term used to indicate gradually softer. Ref. Change of Volume table, 

Often the following symbol is used instead: 

 

 



Dotted Notes and rests 

Notes and rests may be lengthened by the addition of a dot or dots immediately afterwards. 

One dot lengthens the time interval by half the value of the original note or rest. 

Two dots lengthens the time interval by three quarters the value of the original note or rest. 

i.e. half of the value(first dot), plus a quarter of the value(second dot). 

Examples A dotted crochet is equivalent to three quavers. Add a second dot and it is now 

equivalent to seven semiquavers: 

 



Ghost Note 

Note that is: implied / unintentionally sounded / faintly sounded for effect. Typically found 

notated in transcriptions where say in the case of the guitar, the guitarist has unintentionally 

struck another string where the fret hand has dampened the note (thus sounding at a low 

level) or that some other action has caused another string to slightly ring. 

 



Grace Note 

The grace note, commonly drawn as a miniature eighth note with a small crossbar through 

the stem, is used to signify notes of such a short length that it is unnecessary to compute 

their exact length. (The grace note is not counted when adding up the beats in a measure - 

its short time slice being commonly taken from the preceding note, although sometimes the 

following note.) 

There is another less commonly used grace note - drawn without the small crossbar 

through the stem. It is usually found in old music. However with this interpretation the grace 

note without the crossbar, is to play it as if it were a real note of time value indicated by its 

stem: 

 

 

Traditional terms: 

acciaccatura - bar 

appoggiatura - no bar 

 

 



Intervals 

For a piano the smallest distance between two notes is called a semitone. E.g. the distance 

between C (white key) and C# (black key), whereas the interval between C (white key) and 

D (white key) is 2 intervals - this is referred to as a tone. 

For the Key of C Major - the intervals are: 

 

               

C Interval D Interval E Interval F Interval G Interval A Interval B Interval C 

 2 = Tone  2 = Tone  1=Semi - tone  2 = Tone  2 = Tone  2 = Tone  1=Semi - tone  

               

Note: Tone is often referred to as a whole step. Semitone as a half step. 

 

 



Key 

Specifies the key of the composition. It consists of a group of sharps or flats, never a 

mixture of both*. The adoption of a key signature eases the legibility of a piece of music. For 

example if a piece was written in C# Major without the key signature, then the number of 

sharp accidentals cluttering up the score would make the piece untidy and difficult to follow. 

* Note in Avrella it is possible to set a custom key signature which does consist of sharps 

and flats - this was a requested option. 

 



Mordent 

Defined as three notes played in the time of the principle note: Principal note; note above 

(upper mordent) / note below (lower mordent); principal note. 

{The file 'C:\Data\hg\AIT\Libraries\..\..\..\..\Dev\Avrella\hlp\mordent.bmp' could not be found.} 

A double mordent repeats the first mordent. 



Pause (Italian: Fermata) symbol 

To indicate that a note or a group of notes must be held for a pause in the music. The dot is 

nearest to the head of the note.  

 

 



Simple Time 

Simple time signatures are straightforward in that the measure beat is an undotted note. It is 

clear how many beats there are in the each measure plus what is the value of the note that 

is used to signify a beat. 

In this example: 

 

The time signature is 3/4. The '3' indicates that there are 3 beats in every bar, and the '4' 

indicates that each beat is one quarter note long. Note that the eighth notes are beamed 

together in groups of two which equals one quarter note. Notating it this way groups sub 1/4 

notes in to beat periods. 

All simple time signatures follow certain rules: 

The beat is an un-dotted note. 

The beat may be cleanly divided by two into two note values (i.e. with no remainder part).  

With the exception of a time signature with a 3 to indicate the beats per measure (top 

figure), the top figure is not divisible by 3. 

The number of beats in every measure are shown (i.e.3/4 means: 3 quarter note beats in 

every measure). 

 

 

 



Slur 

Notes marked with a slur are to be played as smoothly as possible, without any interruption 

in sound. 

 

 



Staccatissimo 

Shown as a small triangular symbol above or below the head of a note - shortens the note 

by three quarters. 

 



Staccato 

Shown as a dot above or below the head of a note - shortens the note by a half. 

 

 



Tempo 

The speed of the beats in a piece of music is called the tempo and it is usually marked at 

the start of a piece of music by a word or phrase. For example the composer might say 

'Very fast' or 'Fast with spirit' or 'Slowly'. At the time that this system was becoming 

commonplace Italy dominated the musical world, and consequently musicians of all nations 

tended to use the Italian words for these instructions. There are very many of these words 

in use. The Tempo table, lists the commonly used terms which are available via the Text 

Entry tabbed dialog in Avrella. (Any terms that are not available through the Text Entry 

tabbed dialog may be entered as custom text.) 

Often the tempo is marked explicitly as a metronome mark which may be selected via the 

the Tempo dialog box For example: 

 

This indicates that the music should be played at a fast tempo of 120 beats a minute.  

Typically medium tempo is described for most as somewhere between 60 to 90 beats per 

minute. Fast tempo being above 90 and slow tempo being below 60. Using the general 

terms Slow tempo, Medium tempo and Fast tempo is to give a rough idea, whereas to use a 

metronome marking is to be specific about the speed. 

 

 

 



Time Signature 

Specifies the number of beats in a bar and the value of each beat. The upper figure 

(numerator) is the number of beats in each bar. The lower figure (denominator) specifies the 

value of each beat. For example 2/4 time indicates 2 beats in each bar, with each beat 

being a crotchet  

 



Tone 

Usage #1: To describe difference in pitch (interval) equivalent to two semi tones. 

Usage #2: the quality of a musical instrument or voice. 

 

 



Tremolo 

1. Stringed instrument: a rapid reiteration of a note by back and forth strokes of the bow.  

2. Stringed instruments and other instruments: fast alternation between 2 notes.  

Note: A tremolo is the rapid iteration or alternation of notes, whereas vibrato is the 

fluctuation of pitch. 

 

 



Tuplet 

Generic term given to a group of notes where a different beat is required.  

Examples 

 

  

Tuplet 

Type 
Description 

  

Triplet 

A group of three notes played in the same time as two notes of the same note 

value as in this example: 

 

Quintolet 

Simple time: A group of 5 notes played in the same time as 4 notes of the same 

note value as in this example. Compound time: A group of 5 notes played in the 

same time as 3 notes of the same note value as in this example. 

Septolet 

Simple time: A group of 7 notes played in the same time as 4 notes of the same 

note value as in this example. Compound time: A group of 6 notes played in the 

same time as 3 notes of the same note value as in this example. 

 

 

 



Turn 

The basic sign for the turn (horizontal): 

 

The turn may be shown vertical, mirrored, a bisecting stroke drawn through it, plus include 

accidentals above or below the turn.  

Some basic explanations: 

Turn written above a note 

When written above a note it is played as a group of 4 notes in the following order (a) the 

note above the principal note (b) the principal note (c) the note below (d) the principal note. 

Including an accidental above the turn sign alters the higher note of the turn; including an 

accidental below the turn alters the lower note. Otherwise only notes of the diatonic scale 

are used. 

 

Inverted turn 

 

For an inverted turn written again as a group of 4 notes in the following order (a) the note 

below the principal note (b) the principal note (c) the note above (d) the principal note.  

There are many more possibilities explanations of which are too extensive to detail here. 

For further information on musical theory / notation etc. - ref.: bibliography 



Vibrato 

A rapid regular fluctuation in pitch. 

 



Amplitude 

Strength of a signal.  

In acoustic terms: Amplitude is the fluctuation in the air pressure caused by a sound.  

In (analogue) electrical terms: The voltage of a signal. 

 

 



DAC (Digital-to-analogue conversion) 

Method of converting digital signals (on and off) to an analogue signal. ADC is the reverse 

operation. 

Digital signals are used in modern day electronic equipment.  

To distinguish between analogue and digital signals it might be easiest to consider the 

modern day stages between recording an orchestra and listening to the resultant CD in your 

living room.  

The natural analogue sound waves are picked up by microphones which produce an 

analogue electrical signal. 

This analogue signal is converted to a digital representation for transfer to a digital tape 

recorder. 

After the necessary digital mixing and production, a CD is pressed containing the digital 

representation of the concert performance. 

On playing back the CD the digital signal on the CD is converted to an analogue signal by 

the CD player for output to an amplifier and speakers. 

 

The above is a simplified account, but the essential stages are there. 

 

    



Decibel 

A decibel (dB) is a logarithmic unit which in acoustics is used to compare the intensity of 

sound.  

0dB - the quietest sound that a person with normal hearing can detect. 

60dB - normal conversation. 

90dB - a loud factory environment. 

120dB - a nearby clap of thunder. 

140dB - threshold of pain. 

 

Sound levels above 85 dB have the potential to cause permanent damage to a persons 

hearing. (Ref: www.dangerousdecibels.org) 



Hertz 

A Hertz is defined as one cycle per second. In acoustics this is the unit which measures the 

frequency of a note. (The frequency of middle C is 261.6Hz for the Equal Tempered scale. 

The human ear can usually detect frequencies in the range 20Hz - 20kHz.)  

 



New command (File menu) 

Use this command to create a new document in Avrella. Select this command will prompt 

you for the Composition Details in the Details dialog box. 

Having entered the details and clicking OK, you will be prompted to define the Music Sheet 

Framework in the Music Sheet Framework dialog box  

You can open an existing document with the Open command. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+N 

 

 

 



Open command (File menu) 

Use this command to open an existing document in a new window. You can open multiple 

documents at once. Use the Window menu to switch among the multiple open documents. 

See Window 1, 2, ... command. 

Specify the type of document you wish to create: 

Avrella score document type *.avrella 

Import MIDI type file(*.MID) to Avrella type document 

You can create new documents with the New command. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+O 

 



Close command (File menu) 

Use this command to close all windows containing the active document. Avrella prompts 

you to save any unsaved changes to your document before you close it. If you close a 

document without saving, you lose all changes made since the last time you saved it. 

Before closing an untitled document, Avrella displays the Save As dialog box and prompts 

you to name and save the document. 

 



Save command (File menu) 

Use this command to save the active document to its current name and directory. When you 

save a document for the first time, Avrella displays the Save As dialog box so you can name 

your document. If you want to change the name and directory of an existing document 

before you save it, choose the Save As command. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+S 

 

Note: This command is enabled only when there are changes to be saved. 

 



Save As command (File menu) 

Use this command to save and name the active document. Avrella displays the Save As 

dialog box so you can name your document.  

To save a document with its existing name and directory, use the Save command. 

 



Save All command (File menu) 

Use this command to save all the open documents to their current name and directory. 

Shortcuts 

Toolbar  

 

 

 



Print command (File menu) 

Use this command to print a document. This command presents a Print dialog box, where 

you may specify the range of pages to be printed, the number of copies, the destination 

printer, and other printer setup options. 

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+P 

 



Print Preview command (File menu) 

Use this command to display the active document as it would appear when printed. When 

you choose this command, the main window will be replaced with a print preview window in 

which one or two pages will be displayed in their printed format. The Print Preview toolbar 

offers you options to view either one or two pages at a time; move back and forth through 

the document; zoom in and out of pages; and initiate a print job. 

Shortcuts 

Toolbar:  

 

 



Print Setup command (File menu) 

Use this command to select a printer and a printer connection. This command presents a 

Print Setup dialog box, where you specify the printer and its connection. 



Exit command (File menu) 

Use this command to end your Avrella session. You can also use the Close command on 

the application Control menu. Avrella prompts you to save documents with unsaved 

changes. 

Shortcuts 

Mouse: Double-click the application's Control menu button. 

 

Keys: ALT+F4 



Cut command (Edit menu) 

Use this command to remove the currently selected data from the document and put it on 

the application data buffer*. This command is unavailable if there is no data currently 

selected. 

Cutting data to the application data buffer* replaces the contents previously stored there. 

(*Note: For Lyric data, application data buffer to read clipboard.)  

Shortcuts 

Toolbar:  

 

Keys: CTRL+X 

 



Copy command (Edit menu) 

Use this command to copy selected data onto the application data buffer*. This command is 

unavailable if there is no data currently selected. 

Copying data to the application data buffer* replaces the contents previously stored there. 

(*Note: For Lyric data, application data buffer to read clipboard.)  

Shortcuts 

Toolbar:  

 

Keys:  

CTRL+C 

 



Paste command (Edit menu) 

Use this command to insert a copy of the application data buffer* contents at the insertion 

point. This command is unavailable if the application data buffer* is empty. 

(*Note: For Lyric data, application data buffer to read clipboard.)  

Shortcuts 

Toolbar:  

Keys: CTRL+V 

 



Standard Entry command (Edit menu) 

Use this command to select standard input entry. Typically this command is selected after 

you have been using one of the palette tools such as the crescendo tool from the Standard 

Tools Palette. 

Shortcut 

Toolbar:  

 

Keys:  

CTRL+V 

 



Clear Current Measure command (Edit menu) 

Use this command to clear the current measure - the current measure being indicated by 

where the cursor is. (The current measure number is displayed in the Status Bar. ) Note: 

Only applies to measure on active staff. 

Shortcuts 

Keys: CTRL+K 

Popup: Right click context sensitive menu 

(Note: popup menu is not enabled for Tablature staff selection.) 

 



Hard Clear Current Measure command (Edit 

menu) 

Use this command to hard* clear the current measure - the current measure being indicated 

by where the cursor is. (The current measure number is displayed in the Status Bar. ) Note: 

Only applies to measure on active staff. 

* Hard clear - in addition to normal clear - deletes Tempo, Clef, Key and Time Signature 

information. 

Note: You may delete Tempo, Clef, Key Signatures via the Pull Right Menu 

Shortcuts 

Keys: CTRL+H 

 

 



Items to delete in addition to notation Dialog 

For Hard clear. Select items in addition to notation that are to be deleted: 

 

  

Item  

Clef Select to delete any Clef(s) in this measure for this staff. 

Key Signature Select to delete any Key Signature for all staffs for this measure. 

Time Signature Select to delete any Time Signature for all staffs for this measure. 

Tempo Select to delete any Tempo for all staffs for this measure. 

 

 

 



Delete Measure command (Edit menu) 

Use this command to delete a range of measures in the system. On selecting this command 

the Delete Measures dialog box is displayed. 

 



Delete / Insert Measure Dialog / Insert Page 

Dialog 

Delete Measure Dialog 

Delete selected measure range. 

Measures spin button 

Set the total number of measures to be deleted. For example if the current measure 

selected is measure no. 2 then just setting the value at one will remove this measure 2 from 

the system, plus all associated notation etc. - Measure 3 will then become measure 2 etc. 

Setting the value to 10 will remove measures 2 through to 11 - the range that will be deleted 

is displayed in the caption bar. 

OK. and Cancel pushbuttons 

Insert Measure Dialog 

Insert specified number of measures. 

Measures spin button 

Set the total number of measures to be inserted. For example if the current measure 

selected is measure no. 2 then just setting the value at one will insert one measure. 

The text below the Measures Spin button displays the Current Total of measure numbers 

for the score, plus the New Total of measure numbers for the score if exiting Dialog via OK 

 

  

Position  

Prior Insert measure(s) prior to current selected measure 

After Insert measure(s) after current selected measure 

OK. and Cancel pushbuttons 

Insert Page Dialog 

Insert specified number of pages. 

Measures spin button 



Set the total number of pages to be inserted. For example if the current page selected is 

page no. 2 then just setting the value at one will insert one page. 

 

  

Position  

Prior Insert page(s) prior to current page 

After Insert page(s) after current page 

OK. and Cancel pushbuttons 

 

    



Lyrics command (Edit menu) 

Use this command to set the lyric editing mode to active. Edit mode is selected so that the 

lyrics may be input directly into the score on the screen. By de-selecting this to View mode 

the lyric line is displayed as it will really look when the document is printed. The View mode 

is the usual setting when not entering lyrics.  

Ref.: Lyrics - overview for further information 

Shortcut 

Toolbar: 

 

 



Delete Lyric Line command (Edit menu) 

Use this command to delete an entire lyric line - This applies to the whole score - i.e. it 

deletes the entire lyric line - from the first system to the last system. (If you just wish to 

delete the lyric line for the system then ensure that you are in edit mode for lyrics then by 

holding down the left mouse button mark the lyric text to be deleted - then right click the 

mouse button and select Cut from the pop-up menu. Ref.: Lyrics -overview for further 

information.) 

 



Go To Measure/Page Dialog 

Go To desired measure/page. 

Measures/Page spin button 

Set the destination measure/page and click OK. 

OK. and Cancel pushbuttons 

 

    



View Toolbars command 

Use this command to display and hide the various Toolbars, which includes buttons for 

some of the most common commands in Avrella, such as File Open. On selecting this 

command the Toolbars dialog box is displayed from which you may decide upon which 

toolbars to display. 

 



View Status Bar Command 

Use this command to display and hide the Status Bar, which describes the action to be 

executed by the selected menu item or depressed toolbar button, and keyboard latch state. 

A check mark appears next to the menu item when the Status Bar is displayed. 

See Status Bar for help on using the status bar. 



View Zoom command 

Use this command to change the scale of the display. On selecting this command the Zoom 

dialog box is displayed. 

Shortcut 

Toolbar:  

 



View Refresh Display command 

On occasion having dragged a note into position or some such similar action, you may find 

that a trace of the note has been left behind. If this occurs this is due to the respective 

section of the screen not having been fully redrawn correctly. Using this command will enact 

a complete refresh operation. 

Shortcut 

Keys:  

CTRL+F 



View Volume Graph command 

Select this command to view the volume levels for the notation in the score. 

The volume graph is presented using the bottom and top staff lines as the minimum and 

maximum volumes. Thus the bottom staff line represents MIDI volume 0 and the top staff 

line represents MIDI volume 128. Best illustrated by the example below: 

 

 



Insert Note command 

Insert note into score. The type of note inserted will depend on the current format setting for 

the time interval set plus accidental etc.. 

The note style may subsequently be changed by use of the Note property dialog; popup 

menu, as well as changing the pitch by dragging the note to desired position. 

Shortcut 

Keys: CTRL+E 

 



Insert Notation command - Clef / Key Signature / 

Tempo / Time Signature 

Option to insert Clef, Key Signature, Tempo and Time Signature notation supplemental to 

the 'base' notation defined via the Framework dialog box (Clef, Key, Time) and Document 

Setup (Tempo) 

Further explanation: On creating a score the 'base' time signature key signature, clefs and 

tempos are defined. Often these four variables remain unchanged throughout. However the 

instance arises for which the composer may wish to change the clef , and / or tempo and / 

or key signature and / or Time signature. It is for this purpose that these commands are 

included. 

 

  

Notation Type Description 

Clef On selecting this option a Clef tabbed dialog box is displayed 

Key 

Signature 
On selecting this option a Key Signature tabbed dialog box is displayed 

Tempo On selecting this option a Tempo dialog box is displayed 

Time 

Signature 
On selecting this option a Time Signature tabbed dialog box is displayed 

Note: 
You may subsequently delete any Tempo, Clef, Key Signatures inserted via 

the Pull Right Menu 

 



Rest command (Insert menu) 

Insert rest into score. The type of note inserted will depend on the current format setting for 

the time interval set plus dots 

The rest style may subsequently be changed by use of the Rest property dialog. 

 



Lyric Line command (Insert Menu) 

Use this command to insert a lyric line into the score. To insert a lyric line, position the 

cursor below the staff on the first page and system for which the Lyric line is required. On 

selecting this command the Insert Lyric Line dialog box is displayed. 

Notes: Insertion of a lyric line is very much like including a new staff in the system 

framework - i.e. the lyric line is effective over the whole score, though of course on initial 

entry it is blank, and you choose just where to place the lyric text. To emphasise that the 

lyric line is effectively part of the framework - lyric lines may only be inserted when the 

cursor is below the appropriate staff on System 1 

 



Text command (Insert Menu) 

Use this command to insert a text into the score. On selecting this command the Insert Text 

Tabbed dialog is displayed. 

 



Measure(s) command (Insert Menu) 

Use this command to insert a range of measures in the system. On selecting this command 

the Insert Measures dialog box is displayed. 

 



Tuplet command (Format Menu) 

Set entry mode to tuplet.. 

Shortcut 

Toolbar: 

 



Tuplet Ratio Dialog 

The Tuplet ratio dialog permits selection of standard tuplet types, once having selected 

tuplet command 

 

  

Type  

Triplet through to Septolet 

radio buttons 
Sets the appropriate tuplet type. 

Include number checkbox Select to display the number adjacent to tuplet(default) 

Explicit Ratio checkbox 
If display number, select to display the explicit ratio. E.g. if triplet 

instead of displaying '3' display '3:. 

 

OK. and Cancel pushbuttons 

 

    



Lyric command (Format Menu) 

Displays Lyric Format Dialog so that character format for selected lyric line may be set. 

 



Record command (Tools menu) 

Currently record facility from a Midi keyboard is not supported. However this is to be 

implemented in a future 1.xx release of Avrella. Although by use of a Midi sequencer you 

may record a Midi file and then import the generated Midi file into Avrella. A recommended 

Midi sequencer is Jazz++ freely available from www.jazzware.com  

http://www.jazzware.com/


Play command (Tools menu) 

Starts playing of the current score (which has the input focus) through the PC sound card. 

Shortcuts 

Toolbar: 

 

 



Pause command (Tools menu) 

Pauses the playing of the current score (once started). 

Shortcuts 

Toolbar: 

 

Note: On selecting Pause the menu option then displays 'Continue'. Once play resumed the 

menu option reverts to 'Pause' 

 



Stop command (Tools menu) 

Stops the playing of the current score (once started). 

Shortcuts 

Toolbar: 

 

 



Volume command (Tools menu) 

Use this command to set the volume for a range of measures for the selected staff. On 

selecting this command the Set Volume for Measure Range Dialog is displayed. 



Options command (Tools menu) 

Use this command allows set up various options for Avrella. via the tabbed dialog with the 

following Pages: 

General  

Display  

MIDI Out  

Status Bar  

Guitar  

Misc.  

 



Insert Page (Score menu) 

Use this command to insert a page(s) into the score. On selecting this command the Insert 

Pages dialog box is displayed. 

 

 



Tip of the Day command (Help menu) 

Use this command to display the Tip of the Day Dialog 

 



Properties - General Sheet 

Displays general properties for selected note / chord / rest 

 

  

Accidental*  

Double sharp to 

Double flat radio 

buttons 

Select the appropriate accidental type required. (Note: There is an 

alternative short cut (for notes, not chords) for this operation - without 

use of Properties Dialog highlight note head (line up cursor with head) 

and press S. (F - flat, N - natural, O - off))  

Bracket checkbox 

Bracket the accidental - typically for case where Key Signature 

indicates that note is of this accidental type, but the composer just 

wishes to re-emphasise the state.  

* disabled for rest 

  

Time Interval   

Semibreve (whole) through to Hemidemisemiquaver 

(sixty-fourth) radio buttons 

Select the appropriate note /rest 

time interval required. 

 

  

Dots  

None through to 

double dots radio 

buttons 

One dot lengthens the time interval by half the value of the original 

note or rest. Two dots lengthens the time interval by three quarters the 

value of the original note or rest. 

 

  

Tie*  



Tie note to left hand note (<-) or tie note to 

right hand note(->) radio buttons 

Tie note to preceding or following note. (Must be 

set up for both notes concerned.) 

* disabled for rest 

 

  

Vol.  

spin 

control 

Use this control to set the selected note / chord to desired midi volume. (1 through 

to 127.) 

(Note: There is an alternative short cut for this operation - without use of Properties 

Dialog highlight note head (line up cursor with head) and Ctrl + u to increase and 

Ctrl + d to decrease volume by 1. Use upper case U & D to increase / decrease by 

steps of 10. i.e. Ctrl + U to increase and Ctrl + D to decrease volume by 10.)  

 



Properties - Style Sheet 

Displays style properties for selected note / chord. 

  

Tail   

Up / Down 

radio 

buttons 

Set the tail direction to point up or down. (Note: There is an alternative short 

cut for this operation - without use of Properties Dialog - highlight note head - 

click on mouse right hand button to display popup menu and then select 'flip 

tail'. 

 

  

Beam  

Beam note to left hand note (<-) or 

beam note to right 

Beam note to preceding or following note. (Given 

allowable time interval for note value.)  

 

  

Parentheses  

Paren. checkbox Brackets the note to indicate optional note. 

 

  

Note head  

Standard through to triangular radio buttons Select non standard head type.  

 



Properties - Ornamentation 

Displays main ornamentation properties for selected note. 

 

  

Duration  

Include Include duration marking as defined by radio buttons below. 

Staccato radio button Display Staccato 

Staccato + dash radio button Display mezzo staccato 

Staccatissimo radio button Display Staccatissimo 

Dash radio button Display dash 

 

  

Mordent  

Include Display Mordent 

Lower checkbox Define style as lower.  

Double checkbox Define Mordent style as double. 

 

  

Beam repeat (Note: Beam repeat disabled for eight notes and less.) 

Include Include beam repeat marks. 

Radio buttons 1 

- 4 
Set marks 1 to 4 

Style push- Select to display Beam Repeat Style dialog box which may be used to add 



button a tremolo symbol etc. 

 

  

Accent  

Include Include accent symbol. 

Horiz, Display accent symbol horizontally. 

 

  

Trill  

Include Include.  

Style push-

button 

Select to display Trill Style dialog box which may be used to further define 

trill style. 

 

  

Turn  

Include Include.  

Style push-

button 

Select to display Turn style dialog box which may be used to further define 

turn style. 

.  

    



Properties - Ornamentation #2 

Displays extended ornamentation properties for selected note. 

 

  

Grace Note  

Include Include grace note. 

Style push-

button 
Select to display Grace Note Style dialog box. 

X offset Set the horizontal distance between grace note and associate note. 

Default push-

button 
Sets default X position median plus proportional.  

Proportional 

Set for spacing between the grace note and associate note to remain 

proportional - dependant on the measure width. Consequently the grace note 

will be drawn closer to the associate note as the measure width is reduced - 

opposite if you increase the measure width. Not setting this checkbox results 

in the space being the same whatever the measure width. 

 

 

 

 



Properties - Tablature - Note 

Defines tablature display for stringed instrument - typically guitar / bass guitar.  

 

  

Checkbox  

Associate* Selection links the note with the tab figure in the tab staff below. 

Auto update Select to automatically update tab figure when moving note etc. 

Optional ( ) Brackets the tab figure. 

* Note that the tab figure displayed is shown for regular tuning and it also depends on 

whether or not the Standard checkbox in Tools -> Options -> Guitar has been selected so 

that the tab entry treats the notation entered as an octave higher. (Guitar music notation is 

virtually always written an octave higher than it sounds.) 

 

  

Manual entry Used when Auto update not selected - for manual control of string / fret no. 

String Adjust for String position 1->6 

Fret No. Adjust for Fret position 0->24 

 

  

Fret 

Median 
Used when Auto update selected.  

Spin 

Control 

Adjust so that may specify the fret 'median' so that the note is placed in the 

appropriate section of the fretboard - e.g. If set to 5 will select fret range 3 to 7 

(assuming note not at high or low end). 

 



Properties - Chord Diagram 

Allows the set up of a chord diagram. 

The following are common to both the Chord Properties Tab and the Chord Diagram 

(Guitar Palette Tool)  

(Edit) Title... push button 

Select this to enter or modify the chord diagram title. On selecting this push button the 

Chord Title dialog box is displayed. Having entered the chord title; on closing the dialog box 

via the OK. pushbutton the chord title is displayed above the chord diagram. 

Miniature barre buttons 

There are 6 barre buttons each one above a guitar string. Their purpose is for drawing a 

barre for the chord diagram. Only 2 buttons may be selected at a time to represent the start 

point and end point of the barre. If there are any open string markers set then the barre will 

not be drawn. 

Picture Box displaying chord diagram 

The picture box displays how the chord diagram will appear in the score. To put in finger 

position markers, ensure that the finger marker is selected, then line up the cursor on the 

appropriate string and fret position and click the left hand mouse button - a finger position 

will now be drawn on the appropriate sting and fret position that you clicked on. To insert 

(for example) a barre for the chord from the 6th string to the first string, press the miniature 

button above the 6th string and then the miniature button above the first string. Provided 

that no open strings are marked a barre will be drawn from the 6th sting to the 1st string. 

 

  

Marker 

Allows selection of appropriate 

tool for marking chord 

diagram. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_circ.bmp' 

could not be found.} 

Select the finger position 

marker tool for inserting a 

finger position in the chord 

diagram. 



{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_cros.bmp' 

could not be found.} 

Select the position cross 

marker tool for inserting a 

cross position in the chord 

diagram. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgeras.bmp' 

could not be found.} 

Select the erase marker tool 

for deleting a finger position or 

cross marking in the chord 

diagram - for the case where 

no marking is on the string at 

all (Note: If you merely wish to 

move the finger position 

marking from e.g. 1st to 2nd 

fret, then merely click on 2nd 

fret position with the finger 

position marker tool. 

 

  

Show fret number checkbox  Displays fret number alongside chord diagram. 

 

  

Font fret no... 

Button 

Select this button to set up the font settings for the fret number. On selecting 

this button a Font dialog box is displayed 

 

The following are only included with Chord Properties Tab: 

 

  

Associate chord diagram checkbox Associates chord diagram with notation. 

 



  

Fret number spinbutton Set the fret number for the chord diagram diagram. 

  

  

Hide 

checkbox 

Do not display the chord diagram in the score - for situations where you may 

wish to print out without chord diagram, but still retain the chord diagram data 

that you have entered. 

 

  

X-Y offset  

Zero push button Centres X and Y slider controls. 

X (horizontal)slider control Moves chord diagram diagram in the X axis. 

Y (horizontal)slider control Moves chord diagram diagram in the Y axis. 

Example 

Entering A major (6 string barre) at 5th fret of the chord diagram. If selected via Chord 

Properties ensure that Associate diagram checkbox is set and that the chord notation is 

highlighted (has the cyan box around it as well as the notes being highlighted). Click on 

Show fret no. checkbox and set fret no. to 5. Select finger position marker tool ({The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlg_circ.bmp' could not be found.}) and place 

the arrow over the 6th string, 5th fret position and right click the mouse. Repeat for 5th 

string 7th fret, 4th string 7th fret, 3rd string 6th fret, 2nd string 5th fret and 1st string 5th fret. 

Having drawn the marker positions for the chord, insert a barre. Click the miniature barre 

button above the 6th string and then click the miniature barre button above the 1st string. 

Now enter the chord title. Select Title button, type in A maj. and select OK.  

 

 

Note: In this example for the score a tablature staff is below the musical notation staff - thus 

the Tab property page is also displayed. 



 

    



Properties - Tablature - Chord 

Defines tablature display for stringed instrument - typically guitar / bass guitar. 

 

  

Checkbox  

Associate Selection links the chord notes with the tab numbers in the tab staff below. 

 

 

  

Manual 

entry 

Enabled when associate check box is set. There is no auto update for chords, 

thus these controls are used to specify: Whether to include a marking for this 

string, and if so the string / fret number. 

Include 
Set to include tab marking for this string. If not set String, Fret No. and optional 

controls are disabled. 

String Adjust for String position 1->6. 

Fret No. Adjust for Fret position 0->24. 

Optional ( 

) 
Brackets the tab figure. 

 

 

 



Object classification 

This table lists all the type of objects which can be inserted / deleted / copied etc. into a 

score. 

 

   

Object Type Object Family Comments 

Note Notation  

Rest Notation  

Chord Notation  

 

Vibrato / Wide Vibrato / Vibrato + wang bar Mark  

Slur / Free slur Mark  

3 point line Mark  

Line Mark  

Crescendo  Mark  

Decrescendo Mark  

Bracket (Horizontal) Mark  

Accent Mark  

Bend - Slope Mark  

Bend - Straight Mark  

Bend and Release Mark  

Bend - >Hold and Release Mark  



Hammer/Pull  Mark  

   

Chord Chord (non associate)  

   

Accidental Notation (non associate)  

Mordent Notation (non associate)  

Pause Notation (non associate)  

Grace Notation (non associate)  

Turn Notation (non associate)  

Custom Notation (non associate)  

   

Text Text  

   

TextTab TextTab (non associate)  

   

Lyric Lyric  

 

Where non associate is put in brackets - this is to indicate that the object is independent of 

a Note / Chord. It is strongly recommended that where possible the appropriate object be 

selected by association with the relevant notation by use of the Properties Dialogs for 

Objects. 

 



Status Bar Page 

The Status Bar Page allows set up of.options on the Status Bar. 

 

 

  

X Ratio Display X Ratio for highlighted object in status bar 

Volume Display Midi volume for highlighted note in status bar 

 

    



Measures per System Dialog 

Define the measures for selected system(s) 

Measures spin button 

Set the number of measures for the selected system(s) 

 

  

Range Group Box  

This system only. Start 

measure = n  

Select to define just this selected system. 'n' is the measure no. 

for which the system starts. 

This system onwards  
Select to define this selected system plus all those following to 

the end of the score. 

All systems  Select to define all systems in the score. 

 

OK. and Cancel pushbuttons 

 

    



Tempo Dialog 

The Tempo dialog allows the selection of the type of tempo indication to be inserted into the 

score. Controls shown in red are only applicable for the 'Initial Tempo Setting for Document' 

(Accessed through File -> Document Setup, then selecting Tempo Button.  

 

  

Time Interval  

Whole (Semibreve) through to Eighth(Quaver) radio 

buttons 

Sets the appropriate note value 

association 

Dot checkbox Add dot to note value. 

 

  

Beats per minute spinbutton Set beats per minute associated with selected note value 

 

  

Hide 
Check to hide the initial Tempo setting from the display and print output 

(Default behaviour). 

Display only 

Check to display tempo only - and not to print out. On selecting this checkbox 

the Tempo symbol will be shown on the screen by the colour to the right of 

this check box. On selecting Display only the colour of the text Font is set to 

the 'Display Only' colour. Conversely on de-selecting Display Only the colour 

of the text Font is set to black. (Ref.: Display Only colour button below for 

changing the display colour)' 

Use 

parentheses 
Check to display tempo in parentheses (brackets). 

 



  

Font 

Button 

Select this button to set up the font settings for the tempo number. On selecting 

this button a Font dialog box is displayed 

 

  

Display Only 

Colour Button 

Select this button to set up the colour for a clear indication that the 

tempo is set as display only - and will not be printed out 

 

  

Default Button Select this button to set the default settings. 

 

  

Offsets  

Vertical 
The default vertical offset for the initial tempo position is set as 6 half staffline 

space units. above the top of the first staff. 

Horizontal 

The default horizontal offset for the initial tempo position is set at the 'true' start 

of the initial measure (Note that there is an allowance for the first measure of a 

staff to accommodate Clef etc.) The tempo can be offset in the range from -40 to 

50 as a ratio of the width of the measure. Default is set as 0. 

 

OK. and Cancel pushbuttons 

 

 

 

    



Default Midi Volume for Staff / New Document 

Dialog 

 

   

Midi 

Volume 
Dialog Caption  

spin 

control 

Default Midi 

Volume for Staff:  

Sets the default midi volume (1 through to 127) for note entry 

for the selected staff. 

 

Default Midi 

Volume for new 

Document:  

Sets the default midi volume for note entry when creating a 

new document. (All Default Midi Volume for Staff values will 

be set to this value on creating a new document.) 

 

OK. and Cancel pushbuttons 

    



Layout Tab 

Used to override global settings in Document Setup tabbed dialog box (Accent Proportional) 

and Framework Dialog Box (staff links) for this selected measure. 

 

  

Accent 

Proportional 

For any accent associated with a note - if this checkbox is set then the 

spacing between the accent and the note will remain proportional - 

dependant on the measure width. Consequently the accent will be drawn 

closer to the note as the measure width is reduced - opposite if you 

increase the measure width. Not setting this checkbox results in the space 

being the same whatever the measure width. 

LH staff links 
Draws the left hand measure line through from the first staff to the last staff 

in the system. 

Staff No. spin 

button 
Used to select staff number below which link may be set / cleared.  

Link to staff 

below checkbox 
Sets / clears link between staff no. as set by spin button and staff below. 

Set all linked 

pushbutton 
Sets all links between staffs (disabled if all are already set). 

Clear all linked 

pushbutton 
Clears all links between staffs (disabled if all are already cleared). 

RH staff links Functionality is the same as for LH staff links except acts on RH staff links. 

 



Composition Details Tab 

The Composition Details allows set up of score composition information such as 

Composition Title, Author etc. 

Composition Title 

Enter the composition title to appear on the first page at the head of the document. Two 

lines provided. 

Composer 

Enter the details of the composer to appear on the first page at the head of the document. 

Two lines provided. 

Copyright 

Enter the details of any copyright information to appear on the first page at the head of the 

document. Three lines provided. 

Additional Information 

Enter details of any additional information relating to this composition - this information is 

just for notes, comments etc. that you might have - it is not displayed anywhere on the 

score, 

Font Button 

Select this button to set up the font settings for the appropriate details. When the cursor is in 

the composition title edit boxes, the button will display Font Title - indicating that selecting 

the font button will determine the font that is used just for the Composition Title. On 

selecting this button a Font dialog box is displayed 

 

  

Justification 
Sets selected composition title, composer or copyright to the justification as 

defined  

Left Sets left justification. 

Centre Sets centre justification. 



Right Sets right justification. 

 

    



Header / Footer Tab 

* Note - For Footer tab help - read footer instead of header. The operation of Footer 

Tab is identical to that of header - except of course that the information set up is 

displayed at the foot of the page. 

Allows set up of header information 

Header upper/lower line 

Enter header details that will appear at the top of each document page. 

Font Button 

Select this button to set up the font settings for the header. On selecting this button a Font 

dialog box is displayed 

 

  

Justification  

Left Sets left justification. 

Centre Sets centre justification. 

Right Sets right justification. 

 

Output First Page checkbox 

Normally header information is not output for the first page. Selecting this checkbox will 

override this and output the header information for the first page. 

Print for pages where system exceeds one page checkbox 

In the case where there are more staffs in the system than can fit on the printed page, 

setting this checkbox will print out the header details at the top of the first staff of the next 

page for the continuation of the system printout. 

Output codes 



Various codes can be inserted into the header information for the incorporation of page 

number etc. These codes are detailed below: 

 

  

Code Definition 

^P Current document page. 

^p 

Current print page. In the case where there are more staffs in the system than can fit 

on the printed page, this defines the actual printed page. For example if there are 20 

staffs in the system, and printing just the second system outputs 3 pages then the 

document page output(^P) will display 2, whereas ^p will display 4 - indicating the 

actual print page. 

^T System time - as determined by the clock setting on your computer. 

^D System date - as determined by the clock setting on your computer. 

^t File time. 

^d File date. 

^S Staff system number - as determined by the first system number for the page. 

 

 

    



Music Sheet Framework Dialog 

This dialog box is for the setting of the basic score layout. 

Picture Box on left hand side of dialog 

As staffs are entered/modified in this dialog an approximate representation of the score 

layout for the system is drawn here. The active staff (as highlighted in the List box) will be 

displayed with black staff lines. Non active staffs with white staff lines. Any newly inserted 

staff entered using the Insert pushbutton is displayed with red staff lines. 

 

  

List Box on right hand side of dialog 

Describes Staff characteristics 

Type Type of staff: Regular Staff 'Staff', Tab (Guitar), Tab (Bass) 

Title Name of staff 

Ch MIDI channel 

P  Patch No.(MIDI) 

Mute Mute. 

 

  

Staff  

Insert 

push 

button 

Allows insertion of a staff. On selecting this option a Staff Type dialog box is 

displayed. There is a choice of selecting Standard (Regular) type staff, Tab 

(Guitar) staff or Tab (Bass) staff. Having selected the staff type and exiting the 

Staff Type dialog box via OK the new staff will be displayed below the position of 

the staff currently highlighted in the list box. The new staff will be drawn in red to 

indicate that this is a new entry. 



Delete 

push 

button 

Allows deletion of currently highlighted staff. 

Edit 

push 

button 

Allows editing of MIDI and staff name characteristics as displayed in the list box. 

On selecting this option an Instrument Details dialog box is displayed. 

Shortcut - Left double click mouse button when on respective staff in listbox. 

 

  

Show staff titles 

> sys 1 

checkbox 

Displays staff titles past the first system. (Note: In the Instrument Details 

Dialog you have the option of entering a title with a shortened version by 

use of ^n. E.g. "Guitar^nGtr." - will display Guitar for the first system and 

"Gtr." for subsequent systems. 

 

  

Bracket (curly) with lower staff 

checkbox 
Bracket (curly / brace) selected staff with the staff below. 

Bracket (straight) with lower staff 

checkbox 

Bracket (straight) selected staff with the staff number set 

in spin box control.. 

Clear all Clears all brackets settings from the framework. 

 

  

Link staff status  

Text display All linked / None linked / Some linked. 

Set all linked push 

button 

Sets all links between staffs (disabled if all are already set) for 

whole score. 

Clear all linked push Clears all links between staffs (disabled if all are already cleared) 



button for whole score. 

 

  

Initial Clef Type  

Treble, Bass, Alto and Tenor radio buttons 

Having selected the desired staff in the list 

box, the radio button displays the initial clef 

type for this staff, as well as showing the 

clef type for the selected staff in the picture 

box on the left hand side of the dialog. The 

initial clef for the selected staff may be 

changed by selected the appropriate radio 

button. 

Note: Having selected the initial clef type, a 

subsequent clef type may be inserted later 

on in the score for this staff via Insert-

>Notation->Clef menu option. 

8va checkbox 

If a treble or bass clef is selected, then an 

8va symbol may be attached to the clef to 

indicate that the notes displayed are an 

octave above or below, dependant on 

whether the '8' is above or below the clef 

symbol. This option is only for treble and 

bass clefs. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dl

guparrow.bmp' could not be found.} and {The 

file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res

\dlgdownarrow.bmp' could not be found.} 

radio buttons 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\re

s\dlguparrow.bmp' could not be found.} sets 

treble or bass clef type to display an 8 

above the symbol - indicating an octave 

above. 

{The file 



  

 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\re

s\dlgdownarrow.bmp' could not be found.} 

sets treble or bass clef type to display an 8 

below the symbol - indicating an octave 

below. 

 

  

Initial 

Signatures 
 

Key push 

button 

Allows selection of initial key signature for the score. On selecting this 

option a Key Signature tabbed dialog box is displayed 

Time push 

button 

Allows selection of initial time signature for the score. On selecting this 

option a Time Signature tabbed dialog box is displayed 

The current key and time signatures are shown within the Initial signatures group box. 

 

OK. and Cancel pushbuttons 

    



Bar Markings Tab 

Allows various bar markings to the measure to be made. 

 

  

Double 
Mark the end/start of measure border as a double bar, to indicate change of 

time signature or similar. 

Section  Mark the outer bar of a double bar wider. Typically to indicate conclusion etc. 

Repeat 

Dots 
Include repeat dots. 

 

  

Repeat previous bar Inserts repeat symbol to indicate - repeat previous bar 

 

  

Set as last measure Sets this measure as the last in the score (enabled only for last page) 

 

  

End Line  

Check Box Select to display the end line marking above the staff. 

Distance from staff spin 

button 
Sets the distance from staff in units of half staffline line spaces. 

To measure No. 
Set the measure number from the current measure that the Ottava 

marking is to apply to. 

Edit box for end line Insert text associated with end line, typically 1. , 2. etc. 



 



Ottava(8va) Tab 

Allows Ottava plus generic markings to be inserted above / below staff. 

 

  

Position  

Upper Display the 8va marking above the staff. 

Distance from staff spin 

button 

Sets the distance from staff in units of half staffline line 

spaces. 

Lower Display the 8va marking below the staff. 

 

  

To measure 

No. 

Set the measure number from the current measure that the Ottava marking 

is to apply to. 

 

  

Style  

8va/ 8/15ma/15 combo 

select 
Set text marking at start of line as '8va' / '8' / '15ma' / '15'  

bassa 
For case where lower selected append 'bassa' to text 

marking. 

solid Set the line to solid rather than default dashed. 

 

  

Generic  



Generic Select to enter generic text rather than standard 8, 8va etc. 

Edit box for Generic text Generic text edit field. 

 

  

LHS spinbutton Set the start position (as a % of the measure width). 

RHS spinbutton Set the end position (as a % of the measure width). 

 



Note Values 

 

    

Symbol Name Common name Rest Symbol 

 

 
Breve Double whole-note  

 

 
Semibreve Whole-note 

 

 

 

 
Minim half-note 

 

 

 

 

Crochet 

 
quarter-note 

 

 

 

 

Quaver 

 
eighth-note 

 

 

 

 

Semiquaver 

 
sixteenth-note 

 

 

 

 

Demisemiquaver 

 
thirty-second-note 

 

 

 

 
Hemidemisemiquaver sixty-fourth-note 

 

 

 



Change of Volume Table 
    

Italian English French German 

crescendo growing louder en croissant wachsend 

decrescendo(diminuendo) growing softer diminuer diminuieren, vermindern 

forte piano ( fp ) 
Not translated - commence note loud, dropping to soft 

immediately. 

sforzando , sforzato( sf, fz, sfz ) Not translated - forced, accented. 

piu, meno, non troppo Defined in Tempo table, also used for volume 

Book Antiqua Bold Italic seems to be the best common Windows font for indicating the 

symbols in brackets.  

Often instead of crescendo the symbol is used instead 

 

Likewise for decrescendo: 

 

The symbols are selected via the Standard Palette 

 



Tempo Table 

 

    

Italian English French German 

Adagio Not translated - usually means 'slow'. 

Allegratto Not translated - less fast than Allegro 

Allegro Fast Animé, Vite Schnell 

Andante Medium Slow Allant Gehend 

Andantino Not translated - less slow than Andante 

Grave Heavy, Serious Lourd Schwer 

Larghetto Not translated - not as broad as Largo 

Largo Broad Large Breit 

Lento Slow Lent Langsam 

Moderato Moderate Modéré Mässig 

non troppo not too (fast, slow etc.) pas trop nicht zu 

Prestissimo Not translated - faster than Presto 

Presto Very fast Très vite Sehr schnell, Eilig 

Vivace Lively Vif Lebhaft 

Vivacissimo Not translated - livelier than Vivace 

 



Text Entry Tab 

Allows entry of text into the score. 

Edit Box 

Where custom text entry has been selected, use this edit box to input the text. 

 

  

Type 
Sets the type of text predefined: Tempo, Volume etc. 

or Custom.  

Custom Permits entry of custom specific text via Edit box. 

Tempo 
Enter standard tempo term as selected via combo 

box. 

Change of Tempo 
Enter standard change of tempo term as selected via 

combo box. 

Volume 
Enter standard volume term as selected via combo 

box. 

Change of Volume 
Enter standard change of volume term as selected 

via combo box. 

Tempo 
Enter standard tempo term as selected via combo 

box. 

Simultaneous reduction of tempo and 

volume 
Enter standard term as selected via combo box. 

Mood, Degree, Intensity or Style Enter standard term as selected via combo box. 

 

  

Language Sets the required language for the term. 



Italian Use the Italian term. 

English Use the English term. 

French Use the French term. 

German Use the German term. 

Abbreviation(Italian) Abbreviate the Italian term. 

 

Sort Checkbox 

Sorts alphabetically the terms.  

Note: If you require to use the dialog as a means of translation between the terms, do not 

select the Sort checkbox. 

 



Diatonic Scale 

The Diatonic Scales are those of the major and minor keys. Ref.: Scale 

 



Bibliography 

The following is a selected list of books that should help the music student further advance 

their understanding of music notation: 

 

     

Title Author Publisher ISBN Comments 

Music Notation 
Gardner 

Read 

Taplinger 

Publishing Co. 
0800854535 

An often recommended 

book  

Learn to Read Music  
Howard 

Shanet 
Simon & Schuster  0671210270 

Good introduction to the 

fundamentals of learning 

to read music 

Music Notation in the 

Twentieth Century: A 

Practical Guidebook 

Kurt 

Stone 
W W Norton & Co  0393950530 

Many consider this to be 

the best book on music 

notation 

Music Manuscript 

Preparation 

Mona 

Mender 
Scarecrow Press 0810822946  

The AB Guide to Music 

Theory Vol 1 

Eric 

Taylor 

Associated Board 

of the Royal 

Schools of Music 

1854724460  

The AB Guide to Music 

Theory Vol 2 

Eric 

Taylor 

Associated Board 

of the Royal 

Schools of Music 

1854724479  

 

Further details and ordering etc. may be found at online book stores such as 

www.amazon.com etc. 

 

 



 

 

 



Scales - Just and Equal Tempered compared 

Just Scale 

A Just scale is a natural scale based on intervals that can be expressed as an integral 

fraction.* The scale produces cleaner and more pleasing intervals compared to the equal 

tempered scale. The disadvantage of a Just scale is that it is based round the key you are 

playing in. So the tuning for a Just scale for C Major is different to that for D Major.  

* Fraction using integer (whole) numbers e.g. 5/2. Opposed to decimal numbers such as 

5.4, 2.67 etc. 

Equal Tempered Scale 

The equal tempered scale was developed as a compromise for keyboard instruments in 

order that a composition in any key could be played without having to retune the instrument. 

This scale uses constant frequency multiples between the notes.  

To compare the equal tempered scale wiith the Just scale, it is probably best illustrated by 

the table below which compares the tuning for a Just scale for C verses that for an equal 

tempered scale for C. (Based on Middle C frequency of 261.62Hz.) 

 

     

Note 

Just 

tuning 

ratio 

Frequency (Hz.) – 

(rounded to 1st 

decimal place) 

Equal tempered tuning 

ratio (rounded to 4th 

decimal place) 

Frequency (Hz.) – 

(rounded to 1st 

decimal place) 

Middle 

C 
 261.6 (Note 1)   

D 9/8 294.3 1.1225 293.7 

E 5/4 327.0 1.2599 329.6 

F 4/3 348.8 1.3348 349.2 

G 3/2 392.4 1.4983 392.0 

A 5/3 436.0 1.6818 440.0 



B 17/9 494.2 1.8877 493.9 

 

12  2 (12th root of 2 approx. 1.05946309436) represents the frequency ratio between any 

two consecutive notes in a chromatic scale of equal temperament. E.g. For the equal 

tempered scale for middle C (frequency 261.62Hz), the frequency of C# is 277.18. 

Note 1: 261.62 is the figure used for the calculations in the above table. 

 

 



1, 2, ... command (Window menu) 

Avrella displays a list of currently open document windows at the bottom of the Window 

menu. A check mark appears in front of the document name of the active window. Choose a 

document from this list to make its window active.  



File Save As dialog box 

The following options allow you to specify the name and location of the file you're about to 

save: 

Save In Select a folder to save the file in. You can select network paths, computers, drives, 

directories, and folders. 

File Name Type the new filename for this file. 

Note: If you type a pattern using a wildcard (* or ?) in the File Name box and press ENTER, 

the list box displays files matching that pattern in the selected folder. 

Save As Type Select a file type from the drop-down list box. The filename extension 

determines the file type of the saved file. Default id *.avrella 

Save Saves the designated file. 

Standard Save / Save As 

OK. and Cancel pushbuttons 

    



Print dialog box 

The following options allow you to specify how the document should be printed: 

Printer 

This is the active printer and printer connection. Choose the Setup option to change the 

printer and printer connection. 

Setup 

Displays a Print Setup dialog box, so you can select a printer and printer connection. 

Print Range 

Specify the pages you want to print: 

  

All Prints the entire document. 

Selection Prints the currently selected text. 

Pages Prints the range of pages you specify in the From and To boxes. 

Copies 

Specify the number of copies you want to print for the above page range. 

Collate Copies 

Prints copies in page number order, instead of separated multiple copies of each page. 

Print Quality 

Select the quality of the printing. Generally, lower quality printing takes less time to produce. 



Print Preview Toolbar 

The print preview toolbar offers you the following options: 

Print 

Bring up the print dialog box, to start a print job. 

Next Page 

Preview the next printed page. 

Prev Page 

Preview the previous printed page. 

One Page / Two Page 

Preview one or two printed pages at a time. 

Zoom In 

Take a closer look at the printed page. 

Zoom Out 

Take a larger look at the printed page. 

Close 

Return from print preview to the editing window. 

 



Status Bar 

 

 

The status bar is displayed at the bottom of the Avrella window. To display or hide the 

status bar, use the Status Bar command in the View menu. 

The left area of the status bar describes actions of menu items as you use the arrow keys to 

navigate through menus. This area similarly shows messages that describe the actions of 

toolbar buttons as you depress them, before releasing them. 

The next area displays the current page number, plus the page number against the total 

page number, plus also the current measure number. Format: Page n n/t Meas:m  

- where current n is the current page, t total pages and current measure is m 

The right areas of the status bar indicate which of the following keys are latched down: 

Indicator Description 

CAP The Caps Lock key is latched down. 

NUM The Num Lock key is latched down. 

SCRL The Scroll Lock key is latched down. 

Also the Midi Volume* and X Ratio* are displayed to the right if they have been selected via 

Tools->Options->Status Bar Tab 

* For notes and rests when notation highlighted 

    



Lyrics - overview 

Lyrics may easily be inserted into the score and edited on screen.  

Having inserted a Lyric Line and ensuring that the Lyric edit / view is selected to edit just 

enter the lyrics direct into the document. When the lyric line is in edit mode the format of the 

lyric text may be changed via Format -> Lyric menu option.  

 

A brief guide to creating lyrics for your score and setting them up to your liking. 



Toolbars Dialog 

Select desired toolbars for display: 

The toolbars are displayed across the top of the application window, below the menu bar. 

The toolbars provide quick access to many tools used in Avrella. 

 

   

Toolbar name  Description 

Standard 
 

 
General functions File Open, Save etc. 

Notes 
 

 
Specific to notation. 

Navigation  
 

 
Navigating round score - Go To Page etc. 

Format and Presentation 
 

 
Score layout and style 

Playback  Playback score 

Tablature 
 

 
Specific to guitar tablature 

 

OK. and Cancel pushbuttons 

 

    



Zoom Dialog 

Select desired scale for the display: 

OK. and Cancel pushbuttons 

 

    



File Framework command - clef 

Allows the set up of clef.by use of the Clef. tab. 

 



Key Signature tabbed dialog 

Allows the set up of the key signature. It may be set up as a standard key signature or a 

custom key signature by use of the Standard. or Custom. tabs. 

 

    



Time Signature - tabbed dialog 

Allows the set up of the time signature via the tabbed dialogs General. and Font  

 



Insert Lyric Dialog 

This dialog displays a series of radio buttons representing the 4 possible lyric lines that may 

be inserted. Select the appropriate lyric line that is required to be inserted into the score. 

 

  

Radio 

button 
 

Lyric Lines 1 

- 4 

Select the lyric line that is desired - any lyric line number that has already 

been inserted will be greyed out. 

 

Notes: Insertion of a lyric line is very much like including a new staff in the system 

framework - i.e. the lyric line is effective over the whole score, though of course on initial 

entry it is blank, and you choose just where to place the lyric text. To emphasise that the 

lyric line is effectively part of the framework - lyric lines may only be inserted when the 

cursor is below the appropriate staff on System 1 

OK. and Cancel pushbuttons 

 

    



Text Tab Dialog 

Allows the insertion of text into the score. A tabbed dialog is displayed whereby you may 

enter the text via Text Entry. and define the text style via Text Style. tabs. 

 



Set Volume for Measure Range for Staff Dialog 

 

  

Increase / 

Decrease 

Select if the volume is to be increased / decreased over the selected 

range.  

not selected: 
Sets the Midi Volume (1 through to 127) for the notation in the selected 

measure range for the staff. 

selected: 
Sets the Start Midi Volume (1 through to 127) for the notation in the 

selected measure range for the staff. 

(Start) Midi 

Volume 
 

spin control 
 

 

End Midi 

Volume 
Enabled if Increase / Decrease selected. 

spin control 
Set the End Midi Volume (1 through to 127) for the notation in the selected 

measure range (set below) for the staff. 

 

  

Measure 

Range 
 

All 
Specifies all notation for the measures for the staff to be set to the Midi 

Volume specified above. 

Select Range 
Specifies the measure range for the selected staff for which the notation will 

be set to the Midi Volume specified above. 

 



Note: To achieve a desirable decrease / increase in volume over a measure range each 

volume is calculated based on the following: 

vol = start_vol - ((running_tm_prd / meas_range_tm_prd) * vol_diff)  

where: 

  

running_tm_prd 
time period from start of measure range to this note + mid time period 

of the note. 

meas_range_tm_prd total time period over selected measure range 

start_vol Start midi volume 

end_vol End midi volume 

vol_diff start_vol - end_volume 

 

Thus to take an extreme example if setting measure range for 1 measure which just 

contains a whole note (4/4 time) and the start volume is set at 70 and the end volume is set 

at 50, the single whole note will be set at the median: 60. 

OK. and Cancel pushbuttons 

    



General Page 

The General Page allows set up of overall options applicable to operation of Avrella. 

 

  

Note Entry Sets conditions / rules for general note entry. 

Auto Format 

Set so that on entry of notes the position of the note is placed in the x 

position, so that its position from the prior note and / or the trailing note is 

such that it is evenly spaced depending on its time period with relation to 

the other notes in the measure. 

Validate Time 

Interval (always 

set when Auto 

Format set) 

With this set, for note entry into a measure a check is carried out to 

ensure that the note entry does not cause an 'overflow' for the measure. 

For example (4/4 time) on entering 4 1/4 notes, on entering a 5th 1/4 

note, a warning message box will be displayed, stating that the maximum 

number of notes / rests have already been entered for time signature 4/4. 

You have the option to override by selecting 'Yes' or cancel by selecting 

'No'.  

Auto Beam 

On note entry appropriate notes will be beamed to suit the time 

signature. For example (4/4 time) on entering 2 1/8 notes, these will be 

beamed together.  

Mid Line Tail 

down 

Set so that note tail points downwards on entry on mid line of staff 

otherwise up. 

 

  

Cursor Type Specify the cursor type to be displayed. 

Arrow Standard arrow type cursor 

I-Beam I-Beam type cursor as commonly used in Word processing programs.. 

 



  

Tip of the Day Specify the level of tips to be shown if Tip of the Day option is selected. 

Beginner Beginner level. 

Advanced Advanced level. 

 

  

Sticky 

Specify whether buttons selected remain selected after each note entry. E.g. 

Typically with selecting a single dot on entering a note, the next note will not 

require a single dot. Thus if Sticky Dots is not selected (installation default) on 

entering the single dot note, the single dot button will switch off after the note 

entry. 

Accidentals 
Select if you wish the selected accidental button to remain persistent after each 

note entry. 

Dots 
Select if you wish the selected dot button to remain persistent after each note 

entry 

 

  

Drag 

Delay 

 

Set delay in miliseconds after having clicked on an object before you are able to 

drag the object (if draggable).  

[Prevents accidental movement of object on initial selection. Range setting 100 - 

1200 ms. Spin control set to 10ms steps.] 

 

  

Help Level Sets the level of help support in the application. 

Display 

warning 

Shows warning message boxes that are displayed typically when a major 

irreversible operation is about to be carried out. Typically a beginner may 

not be aware of the exact consequences of this operation. However a more 



message boxes experienced user will be aware, and will thus not wish to be bothered by 

such warning messages. 

Display tutorial 

message boxes 

and notes 

Shows tutorial message boxes to aid the new user plus also tutorial notes - 

displayed on dialog boxes.  

 

 



Display Page 

The Display Page allows set up of colour association on screen 

for the presentation of the score.  

 

 

  

Tablature  

Associate Tab - 

blue 

Select to display any tablature numbers as blue that are associated with 

the note in the staff above. 

 

  

Active Note 

/ Symbol 
 

Set 

Set so that on selecting any note or symbol, mark etc. (i.e. by clicking the 

mouse on that symbol - then the appropriate symbol is displayed in the colour 

as shown in the colour picture box. 

Colour  
Select this button to set up the color for the active note or symbol, mark etc. 

On selecting this button a Color dialog box is displayed. 

Colour 

Picture box 
Displays current colour selected. 

 

  

Standard 

Notation Colour 

Note:Basically this is used for the case where two instruments are notated 

on the same staff, and it can be useful therefore to have the two 

instruments notation in different colours so that there is no confusion. 

Refer to Notating two voices on the same staff. 

Primary Colour  Select this button to set up the color for the notation for the first 



(Default is black) instrument. On selecting this button a Color dialog box is displayed. 

Secondary 

Colour 

(Default is cyan) 

Select this button to set up the color for the notation for the second 

instrument. On selecting this button a Color dialog box is displayed. 

Secondary print 

output - as 

primary. 

Select so that for the printed output, the secondary notation track colour is 

the same as the primary notation print colour (default setting). Otherwise 

the secondary print track colour will be the same as that on the screen 

(assuming use of a colour printer). 

 

  

Lyrics  

Background grey 

for edit mode. 

Select to display a gray background when the lyrics are set in edit mode. 

As it is sometimes difficult to always tell whether the lyrics are in display 

mode or edit mode, selecting this option clarifies just which mode is 

selected. 

 

    



Midi Out Page 

The MIDI Out Page allows configuration of sound card for playback. 

 

  

Output device combo box Select an output device available on sound card. 

 

  

Test button Tests the selected output device for sound output  

 

  

Device Capabilities  

Technology Type of the MIDI output device. 

Number of Voices Voices supported by an internal synthesizer device. *  

Number of simultaneous 

notes 

Number of notes that can be played simultaneously by an internal 

synthesizer device.* 

Features Other features. 

*If device selected is a port, field has no meaning and will be set to 0. 

Note: If there are no MIDI output devices the text string ''No MIDI output devices detected." 

is displayed  

 

  

Process 

Repeat Bars 

Select to take account of repeat bar markings and sections on playback and 

export of MIDI files.  

[There are some instances, particularly with MIDI file export where it is not 



desired to take account of repeat bars and sections. Default setting is ON] 

 

 

 

 



Guitar Tab Page 

The Guitar Tab Page allows set up of relation between notation and the display of guitar 

tablature. 

 

  

Tab Entry  

Auto 

Select so that on entering notation, tab is automatically entered in the 

appropriate position in the Tab staff below the notation staff. (Otherwise 

will be set for manual tablature entry.) Note 1 

Fret median edit 

box and up/down 

buttons 

The fret median is used to locate the note in the appropriate section of 

the fretboard - e.g. If set to 5 will select fret range 3 to 7 (assuming note 

not at high or low end). 

Standard 

Select so that on entering notation the appropriate fret position for 

automatic Tab entry treats notation entered as an octave higher. Note: 

Guitar music notation is virtually always written an octave higher than it 

sounds. 

 

  

MIDI 

Import / 

Export 

 

Guitar - 

raise 

octave 

Guitar music notation is commonly written an octave higher than it sounds. By 

selecting raise octave; on importing a MIDI track that is marked as guitar 

(Program Nos. 25 - 32) then the notes imported into the score will be an octave 

above. (Note: This option is linked to the 'Guitar - raise octave' in the MIDI Import 

Criteria Dialog - so selecting this will also ensure that on exporting a score to a 

MIDI file where a staff is marked as guitar then the notes exported will be an 

octave lower.) 



Note 1: If you drag a note out of range for standard guitar / bass tuning. Then it becomes 

fairly straightforward that this is beyond bounds, in that you keep dragging the note either 

down and reaches bottom string "0" limit or up and reaches top string "24" limit. On 

selecting Pull Right Pop up Property Summary menu for a note that is out of bounds, The 

Property Summary Dialog displays a warning message text is shown in red "Warning:This 

note is out of bounds for standard guitar / bass guitar tuning." 

 

 



Misc. Page 

The Miscellaneous Page allows set up of Backup and version update checking. 

 

  

Backup  

Timed 

Document 

Backup every ... 

minutes 

Saves score/document backup copy to a temporary file every set period* 

of minutes, if the document has been modified. (This feature is useful 

should there be for example a power supply failure. The fact that there is a 

temporary backup therefore limits the amount of work that may be lost.) 

On normal closesure of the document the temporary backup file is deleted. 

* 3 to 120 minutes 

Original 

document 

backup 

 

On saving a document, the version of the document prior to saving is 

copied. This backup/previous version copy has the file extension *.avrell! 

 

 

  

Updates  

Check for 

updates 

every ... days 

Select to automatically check every set period* of days for any updates to 

the current installed version.  

* 7 to 60 days. 

Check Now 

Select this button to immediately check whether an update is available.  

Will report back with MessageBox:  

Update available and version number, or  

No update available to current version, or  



Unable to contact website for information. 

 

Notes on Updates: 

1. This is a simple check and after notification of any update, you will have to download the 

new version of the program, and exit your existing program version and install the new 

version over the existing program version. 

2. For the evaluation version of this program the web check update is disabled. It is 

assumed that the current version is installed. (However if in doubt check www.giltrex.com) 

3. By default this option is switched off. If switched on and it finds an update then a 

Message Box will be displayed. If you choose not to download and install the update, fine; 

you will not be notified of the update for another set period of days (assuming that the 

"Check for updates" box is selected). 

4. If you have a firewall (recommended), then on Avrella checking for updates for the first 

time, you will be alerted that the application is trying to access the Internet. For example 

with ZoneAlarm a message "Avrella is trying to access http://www.giltrex.com" or similar will 

be shown. For this example (ZoneAlarm) click "Allow" to proceed and select "Remember 

this setting" checkbox (if you do not want to be bothered by the ZoneAlarm alert for Avrella 

again). 

 

 

  

Option to set up log file - use for support purposes 

For support purposes there is an option to set up a log file to record data whilst the program 

is running. 

To display the Log controls 

* Hold down Ctrl and Right Double click with the mouse. 

* Log Controls Dialog - with "Show Log controls" text. 

* Select OK to display the log controls.  

Note: The log file is opened on program start up, so on selecting the log checkbox, you will 



have to exit and restart the program to start recording data to the log file. 

To hide the Log controls: 

* Hold down Ctrl and Right Double click with the mouse. 

* Log Controls Dialog - with "Hide Log controls" text. 

* Select OK to hide the log controls. 

Log  

Log 
Select to keep a session log. If you require support, then this file may be of use in 

tracking down an issue..  

Purge 

The session files are automatically purged down to 20 files every so often so not to 

exceed 80 files.  

Select this button to manually carry out this action. 

The session files are stored in users Documents directory  

(File name: yyyymmdd_hhmmss_AvrLog.txt) 

 



Tip of the Day Dialog 

Displays Tip of the day. A sequential series of tips on how to use the application. 

 

  

Show Tips on 

startup 
Shows a new tip every time you start Avrella 

Beginner Tips Specify the level of tips to be shown Set - Beginner, Not set - Advanced 

Go to Help 
Enabled where appropriate so that you may launch Help to display 

further information. 

Next Tip Displays the next Tip of the Day 

 



Trill / Accidental Dialog 

The Trill Style / Accidental dialog allows the selection of the type of the appropriate 

accidental mark on to be inserted into the score. 

 

   

Control  Dialog  

( ) 

Puts the accidental in 

parentheses(brackets

) 

Accidenta

l 

Include 
Include accidental 

marking with the Trill 
Trill Style  

Display above 
Display accidental 

above the trill 
Trill Style  

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmdshp.bm

p' could not be found.} 

Select the double 

sharp accidental 
Both 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmshp.bmp' 

could not be found.} 

Select the sharp 

accidental 
Both 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmnat.bmp' 

could not be found.} 

Select the natural 

accidental 
Both 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmflat.bmp' 

could not be found.} 

Select the flat 

accidental 
Both 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmflat.bmp' 

Select the double flat 

accidental 
Both 



could not be found.} 

 

OK. and Cancel push buttons 

 

    



Grace Note Dialog 

The Grace Note dialog allows the selection of the type of grace note indication to be 

inserted into the score. 

 

  

Accidental  

( ) 

Puts the accidental in 

parentheses 

(brackets). 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmdshp.bmp' could 

not be found.} 

Select the double 

sharp accidental 

{The file 'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmshp.bmp' 

could not be found.} 

Select the sharp 

accidental 

{The file 'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmnat.bmp' 

could not be found.} 

Select the natural 

accidental 

{The file 'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmflat.bmp' 

could not be found.} 

Select the flat 

accidental 

{The file 'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dlgmflat.bmp' 

could not be found.} 

Select the double flat 

accidental 

none 

No accidental to be 

displayed alongside 

grace note 

 

  

Time Interval  



Quarter through to  sixty fourth radio 

buttons 

Sets the appropriate note value for the grace 

note 

 

  

Tail  

Up checkbox Sets the appropriate grace note tail up. 

Down checkbox Sets the appropriate grace note tail down. 

 

  

Y Offset  

spin 

control 

Sets the centre offset for the grace note from the associate note. (Y offset range -

10 to 10 in units of a half staffline space units.) 

 

  

Slur 

checkbox 
Draws a slur linking the grace note with the associate (main) note. 

Bar 

checkbox 

Draws bar through grace note.  

(The accurate name for a grace note with a bar through it: acciaccatura and for 

a grace note without a bar through it: appoggiatura.) 

Trail 

checkbox 
Displays the grace note after the associate (main) note. 

 

OK. and Cancel pushbuttons 

 

    



Chord Title Dialog 

The Chord Title dialog allows the entry/modification of the title for a chord diagram. 

Edit Box 

Enter/modify chord title. 

Font Button  

Select this button to set up the font settings for the chord title. On selecting this button a 

Font dialog box is displayed. 

OK. and Cancel pushbuttons 

 

    



Midi velocity (volume) 

Midi Velocity is interpreted as corresponding to volume. The range that may be set is from 0 

through to 127, where 0 is silent, 64 is mezzo piano (mp) and 127 fortississimo (fff).  



Staff Type Dialog 

The Staff Type defines the basic staff type to be used at the selected position in the system 

in the score. 

 

  

Staff Type  

Standard Regular staff type consisting of five lines with four spaces between them. 

Tab(Guitar) 
Standard staff type for six string guitar tab consisting of six lines with five 

spaces between them. 

Tab(Bass) 
Standard staff type for four string bass guitar tab consisting of four lines with 

three spaces between them. 

OK. and Cancel pushbuttons 

 

    



Instrument Details dialog 

The Instrument Details allows set up of staff name, channel, instrument etc. for the staff 

selected. 

Staff Name 

Enter the text description to be displayed to the left of the staff.  

Note: If you are displaying the staff title past the first system and wish to set up a shortened 

version (for subsequent systems) you may do this by use of ^n. For example entering a title 

"Guitar^nGtr." - will display "Guitar" for the first system and "Gtr." for subsequent systems. 

Channel 

Enter the channel no. 1 - 16 to be associated with this staff. 

Device 

Selection of either General MIDI - thus will display the standard 1 - 128 instrument types in 

Instrument / Voice or alternatively you may select a generic 1 -> 128 - thus display raw 1 -> 

128 nos. in Instrument / Voice combo box. 

Instrument / Voice 

Select from 128 instrument types (Device: General MIDI selected) or the raw 1 -> 128 nos. 

(Device: Generic 1->128)  

Mute 

Select so that the staff will not be played back when selecting Tools -> Play. (Typically this 

is selected when the staff is for a voice.) 

Centre on bracket 

Enabled only if Bracket with lower checkbox selected in Music Sheet Framework Dialog. 

Selecting will centre the title text in the centre of the bracket joining this (upper) staff with 

the lower staff. 

Link to staff below 

Sets / clears link between selected staff and staff below. This setting will take effect for the 

whole score.  



E.g. Typical useage might be in a 4 staff score with the 1st staff for voice and subsequent 

staffs for instruments. So as not to clutter the lyrics between 1st and 2nd staff, the link to the 

staff below for staff 1 would be cleared and the links for staff 2 and staff 3 to their respective 

staff would be set. 

(Note - these settings may be overridden for individual measures by use of Format -> 

Current Measure -> Layout Tab. LH / RH staff links setting.) 

Font Button 

Select this button to set up the font settings for the appropriate details. When the cursor is in 

the composition title edit boxes, the button will display Font Title - indicating that selecting 

the font button will determine the font that is used just for the Composition Title. On 

selecting this button a Font dialog box is displayed 

Midi Volume Button 

Select this button to set the default Midi Volume for note entry for the selected staff. On 

selecting this button a Default Midi Volume for Staff Dialog is displayed. (The default Midi 

volume value set is displayed on the button.) 

OK. and Cancel pushbuttons 

    



Clef Tab 

Allows set up of clef type 

Namely Treble, Bass, Alto or Tenor 

 

  

Clef Type  

Treble, Bass, Alto and Tenor radio buttons Select appropriate button for required clef. 

8va checkbox 

If a treble or bass clef is selected, then an 

8va symbol may be attached to the clef to 

indicate that the notes displayed are an 

octave above or below, dependant on 

whether the '8' is above or below the clef 

symbol. This option is only for treble and 

bass clefs. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res\dl

guparrow.bmp' could not be found.} and {The 

file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\res

\dlgdownarrow.bmp' could not be found.} 

radio buttons 

  

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\re

s\dlguparrow.bmp' could not be found.} sets 

treble or bass clef type to display an 8 

above the symbol - indicating an octave 

above. 

{The file 

'C:\Data\hg\AIT\Libraries\..\..\Dev\Avrella\re

s\dlgdownarrow.bmp' could not be found.} 

sets treble or bass clef type to display an 8 

below the symbol - indicating an octave 

below. 

 

 



End Line marking 

It is common practice at the end of compositions, where the composition is to be repeated, 

for end section bar(s) to be marked within lines with a number to indicate on which play 

through the bars are to be played. 

Example: 

 

 

In the example above  

First play through. The piece is played through from bar 1. On reaching bar 10, the 2 

section bar as indicated by the end line bracket marked 1,2. (i.e. 1) is played, before starting 

play again from bar 1. 

Second play through. The piece is played through from bar 1. On reaching bar 10, the 2 

section bar as indicated by the end line bracket marked 1,2. (i.e. 2) is played, before starting 

play again from bar 1. 

Third and final play through. The piece is played through from bar 1. On reaching bar 10, 

the 2 section bar as indicated by the end line bracket marked 3. is played to conclude the 

piece. 



Scale 

A scale is a progression of single notes upwards or downwards in steps to form a series 

within an octave. Ref.: Intervals for the common C Major scale. A scale is used as the basis 

of a composition. In Western music the most commonly used scales are the major and 

minor scales, although throughout the world the number of scales in use is incalculable. 

Some instruments are tuned to a scale that cannot be represented in orthodox notation - 

e.g. Scottish Bagpipe. 

Some commonly used scales: 

 

                 

Scale                 

Major (C) C T D T E S F T G T A T B S C  

Minor (A) A T B S C T D T E S F T G T A  

HarmonicMinor (A) A T B S C T D T E S F 1.5T G# S A  

Pentatonic C T D 1.5T F T G T A 1.5T C      

                 

T = tone, S = semitone 

 

 

 

 



Standard Toolbar 

 

 

 

  

Click To 

 Open a new document. 

 
Open an existing document. Avrella displays the Open dialog box, in which you can 

locate and open the desired file. 

 
Save the active document or template with its current name. If you have not named 

the document, Avrella displays the Save As dialog box. 

 
Saves all open documents with current name. If you have not named the document, 

Avrella displays the Save As dialog box. 

 Remove selected data from the document and stores it in the data buffer. 

 Copy the selection to the data buffer. 

 Insert the contents of the data buffer at the insertion point. 

 Change scale of display. 

 Print the active document. 

 Print preview. 

 Lyric edit mode 

 Standard input entry 

 
Context sensitive help - On running Avrella by clicking on this button and selecting a 

menu item or toolbar button the appropriate help section will appear. 

 



 

 

 

 

 

 

 

 

 

 

 



Notes Toolbar 

 

 

  

Click To 

 Select Whole (Semibreve) note entry mode. 

 Select Half (Minim) note entry mode. 

 Select Quarter (Crochet) note entry mode. 

 Select Eighth (Quaver) note entry mode. 

 Select Sixteenth (Semiquaver) note entry mode. 

 Select Thirty-second (Demisemiquaver) note entry mode. 

 Select Sixty-fourth (Hemidemisemiquaver) note entry mode. 

 Attach flat symbol to note for note entry. 

 Attach natural symbol to note for note entry. 

 Attach sharp symbol to note for note entry. 

 Select tuplet entry mode. 

 Select tuplet ratio dialog. 

 Attach one dot to note for note entry. 

 Attach two dots to note for note entry. 

 

 

 



 

 



Navigation Toolbar 

 

 

  

Click To 

 Go to the first page in the score. 

 Go to the previous page in the score. 

 Go to the next record page in the score. 

 Go to the last record page in the score. 

 Go to a measure in the score. 

 Go to a page in the score. 

 

 

 



Format and Presentation Toolbar 

 

 

  

Click To 

 Select Tabbed Dialog for Current(Active) Measure. 

 Reset Current(Active) measure to standard spacing. 

 Select the Music Sheet Framework dialog box. 

 Select the Document Setup tabbed dialog box. 

 Select the Details tabbed dialog box. 

 

 

 

 

 



Playback Toolbar 

 

 

 

  

Click To 

 

Currently record facility from a Midi keyboard is not supported. However this is to be 

implemented in a future 1.xx release of Avrella. Although by use of a Midi sequencer 

you may record a Midi file and then import the generated A recommended Midi 

sequencer is Jazz++ freely available from www.jazzware.com 

 Play from selected measure. 

 Pause playback. 

 Stop playback. 

 

 

 

 

 

 



Tablature Toolbar 

 

 

  

Click To 

 Reduce fret median value for Tab entry. 

0 -> 22 Fret median value for Tab entry. 

 Increase fret median value for Tab entry. 

 

 

 

 

 

 



Custom (Key Signature) Tab 

Allows set up of a custom key signature. 

Select appropriate sharp or flat buttons for the required custom key signature.  

Display natural 

Display natural checkbox is typically set if wishing to explicitly state that prior sharps / flats 

are cancelled. A typical useage would be where for example the initially key was D Major 

(C# and F#) and subsequently on in the score, the key was being changed to C Major (no 

sharps or flats). In this instance it would be best to select Custom and set the Display 

Natural check boxes for C and F.  

 



General (Time Signature) Tab 

Beats per bar spin button* 

Sets the beats per bar for time signature (upper number). 

 

Beat value radio button* 

Sets the beat value for time signature (lower number). 

 

  

Type 
Sets selected composition title, composer or copyright to the justification as 

defined. 

Standard Allows entry of standard time signature. 

Common 

Time 
Sets the time signature to Common time. 

Alla Breve Sets the time signature to Alla Breve. 

 

* Note the 'Beats per bar' and 'Beat Value' labels are used within the context of simple time 

signatures as opposed to compound time signatures. 



Style (Time Signature) Tab 

Font Button 

Select this button to set up the font settings for the time signature. On selecting this button a 

Font dialog box is displayed 

 

    



Notating two voices on the same staff 

There may be instances for which it is desirable to notate two separate 'voices' on the same 

staff. In the example below the primary voice / notation is set up as black (default) and the 

secondary voice / notation colour is set up as cyan (default) (Ref.: Tools->Options-

>Display.) Having entered the first / primary notation in the usual way, to enter the 

secondary notation hold down the Ctrl + Alt keys and select 'E' (as opposed to the shortcut 

key command Ctrl + E for the primary notation). 

 

 

 

 



Manually entering Tablature 

If you are manually entering tablature (i.e. you have not set Auto so that the tablature is 

automatically associated with the musical notation on the staff above - ref: Guitar Tab. 

Page) 

Then simply put the cursor on the "tab string" that you want to place a number on and press 

the appropriate number. 

 

 

In the example above 

Place the cursor on the 2nd string and press 8 

Move along and place the cursor on the top string and press 8. 

Move along and place the cursor on the 2nd string. To enter a double digit value greater 

than 9, hold the shift key down and press the first figure. Release the shift key and then 

press the second figure. Thus for this example - hold the shift key down - press 1. Release 

the shift key and press 1. 

Move along and place the cursor on the 2nd string and press 8. 

 



MIDI Import Criteria Dialog 

This dialog allows how determine handling of MIDI import. 

 

At the top of the dialog - displays MIDI the file name and format type 

 

  

Parse  Means by which Avrella interprets the Midi file and translates it into notation.  

Auto 

Default selection. (Because the majority of midi files are recordings of actual 

performances by humans and not machines, the data input does not consist of 

perfect 1/4s, 1/8ths, 1/16ths etc. Consequently the Auto selection is 

recommended, which will carry out some additional processing to take this into 

account.)  

Note 

resolution 
 

Quarter - 

32nd 
Rounds the note to the nearest value selected. 

 

  

Options  

Guitar - raise 

octave 

Guitar music notation is commonly written an octave higher than it sounds. 

By selecting raise octave; on importing a MIDI track that is marked as guitar 

(Program Nos. 25 - 32) then the notes imported into the score will be an 

octave above. (Note: This option is linked to the 'Guitar - raise octave' in the 

Guitar Page (Tools -> Options -> Guitar Page) - so selecting this will also 

ensure that on exporting a score to a MIDI file where a staff is marked as 

guitar then the notes exported will be an octave lower.) 

Split 

Keyboard 

Select to split a keyboard track into two separate staffs if the tonal range of 

the track requires it (i.e. typically if notes on the track above and below 



tracks -> 2 

staffs 

middle C) 

(Note this option is typically used when importing a MIDI file that has been 

created straight off a keyboard or via some application in which the keyboard 

track is written as one track. If the MIDI file was created using Avrella and 

the keyboard is assigned two staff - treble and bass, then it is effectively 

already split and thus this option will not be required.) 

 

OK. and Cancel push buttons 

 

    



Volume Table 
  

Italian English 

forte ( f ) Loud 

fortissimo ( ff ) very loud 

fortississimo ( fff ) louder than fortissimo 

mezzo forte ( mf ) medium loud 

mezzo piano ( mp ) medium soft 

piano ( p ) soft 

pianissimo ( pp ) very soft 

pianississimo ( ppp ) softer than pianissimo 

Book Antiqua Bold Italic seems to be the best common Windows font for indicating the 

symbols in brackets. Additional fs indicates levels louder - e.g. fff Additional ps indicates 

levels softer. 

 



Context Help 

 

Use the Context Help command to obtain help on some portion of Avrella. When you 

choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 

question mark. Then click somewhere in the Avrella window, such as another Toolbar 

button. The Help topic will be shown for the item you clicked. 

Shortcut 

Keys: SHIFT+F1 


